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Introduction
About the Software

Historian is designed to help you capture, preserve, and organize digital memories that are impor-
tant to your heritage and history. Historian lets you process your digital “film” and print snapshots
using your own computer and printer. With this powerful memory preservation utility, you can
import media files from any digital-imaging source and create categories and albums, complete
with journaling boxes.

Historian is the perfect digital memory preservation program for scrapbooking. As a digital archi-
vist, you’ll have fun organizing, enhancing, printing, and sharing your favorite photos with family
and friends. Historian lets you:

l Quickly and easily import and organize items from a digital camera, scanner, and existing
files.

l Store and organize digitized video and audio files alongside your images.
l Retouch your pictures to make them look their best. Automatically adjust color balance,
brightness, and contrast. Rotate or trim the image, and correct red eyes.

l Organize and retrieve all your items with virtual categories and tags. Catalog your items by
subject and organize further by people, places, or any category or tag you might add.

l Sort and display items by time, going back centuries.
l Add stories to be stored with each item.
l Sort and organize by facial recognition.
l Create virtual scrapbooks, using amixture of your available images and printable journaling
boxes.

l Back up your archives onto CD-ROM or DVD, preserving your memories for the future.
l E-mail your items to family and friends using your own e-mail program.
l Share your images in a slide show.

Windows System Requirements

If you’re usingWindows, make sure your system configuration meets these minimum require-
ments:

Operating System:

l Windows XP Service Pack 2 (32-bit version only)
l Windows Vista andWindows 7 (all editions, 32-bit and 64-bit)

Processor: 800 MHz 32-bit (x86) or 64-bit (x64) processor

System memory (RAM): XP - 512 MB, Vista or Win 7- 1 GB

Monitor: 1024 x 768 resolution or greater with 32-bit color

Disk space: 1 GB free space on system drive; As needed on system drive or other drive for media
vault storage.

Other:

l Mouse or other pointing device
l High-speed Internet connection is recommended

Actual requirements and product functionality may vary based on your system configuration.
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Note that Vista andWindows 7 work with both 32-bit and 64-bit versions, but that only 32-bit ver-
sions of Windows XP are supported.

Activating Your Software

The first time you open Historian , you will need to activate your product. To activate your soft-
ware, complete the following steps:

1. When the software opens, the Historian Activation dialog box displays. You can choose to
l Buy the software
l Try the software Learn more Try it Out is a trial version where you can create a new
vault and open it 10 times. After 10 opens, you must purchase the software.

l Activate
l Exit

Note: You must be connected to the Internet to Activate your copy of Historian.

2. Choose Activate. The Let's Get Started! dialog box displays.

3. Enter your product serial number, providedwhen you purchased the software.

Note: You can copy the serial number from your email and click Paste product code from
the Windows Clipboard.
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4. ClickUse my existing Panstoria account if you already have an account, or I need to
create a Panstoria account if you do not already have an account.

5. If this is the first time you have installed Historian , you will see a Create a New Vault dialog
box. Follow the instructions to Create a New Vault to get started.

Accessing the Internet

There are several instances where you may need to access the Internet while using Historian .
Whether your software is automatically updating or you want to share to aWeb site, your com-
puter will try to go online. When this happens you may see a warning from your firewall protection,
such as Norton, McAfee, or Microsoft.

If available, choose Always Allow from the options to allow Historian to access the Internet now
and on future occasions.

Automatically Updating Your Software

A link is available from the Welcome tab.
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From the Application News section, choose the hyperlink:Click to check for software
updates.

Once you have downloaded the update, you must install the update file. Double-click on the file
and follow the resulting directions.

Note:Historian accesses the Internet to search for new updates. You may see amessage from
your security software (such as Norton, McAfee, or Microsoft).
Choose Always Allow from the available options to allow Panstoria to always access the Internet
for software updates and/or printing to the Web.

You may schedule the automatic update feature in the User Settings dialog box. To learn more
about automatic update options, refer to User Settings.

When you first open the software, the Auto Update dialog box appears. If an update is available, a
confirmation dialog displays. If you wish to download the update, click Yes. Once you have down-
loaded the update, you must install the update file. Double-click on the file and follow the resulting
directions.

Upgrading Your Software

If you are installing an upgraded version, such as moving from a previous version, you will need to
activate your product. To activate your software, complete the following steps:

1. When you first open the software, Historian will prompt you to activate. 

2. Enter your serial number and click Activate Now.

3. If you are activating an upgraded version, you will need to enter the original (previous version)
serial number as well as the new serial number.

Note: If the previous version still resides on the computer, the Original Serial Number fieldmay be
pre-populated.

4. Enter your serial numbers and click Activate Now.

Note: If you choose Activate later, you will be able to use the software. However, you will be lim-
ited by the number of times you may open your vault(s). To activate your software at a later point,
choose Activate from the Helpmenu.

5. The software will connect to the Web and activate your copy.

6. Once your software is activated, you will see a confirmation message. If you are unable to acti-
vate the software, please contact Customer Support.

Compatible Devices and File Formats

Historian supports files from WIA-, WPD-, and TWAIN-compatible digital cameras and scanners.
DCIM-standard digital cameras and those with a USB connector should be directly supported.

Your mobile phone may also be supported. Each phone has a different process for importingmedia
to a PC. Please refer to your phone documentation to learn more.

Historian also supports the following digital image file types:
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l JPEG/JPE/JPG
l TIF
l PNG
l GIF
l BMP
l RAW

Historian 4.0 will convert images to JPG format, but can keep the original files in any of the sup-
ported original import formats as well. Change this setting in the Imports section of the Options
dialog box. For more information, refer to Setting User Options.

RAW images can be imported andmaintainedwithin the vault. However, if you edit a RAW image
in the Image Editor, the file will be saved as a JPG revision. Maintain your RAW formats by revising
these files in an external editor.

Historian also allows you to store your audio and video files. You must have a video and/or audio
player on your computer. Historian does not play these media files, but will launch your external
player. Examples of free players include iTunes, Windows Media Player, and Real Player. Historian
file support varies based on the player on your machine.

Accessing Tutorials

You can access tutorials and tips on getting started from the Welcome tab.

1. Click Options on the Home ribbon.

2. ChooseGetting started and tutorials.

3. The Panstoria web site will launch with information on getting started with Historian.

Note: You must have Internet access to view this site.

Contacting Customer Support

If you encounter problems with this software, visit the Panstoria Help Zone.

Upload a Diagnostic Report
If a support representative asked you to upload a diagnostic report, perform the following steps: 

1. Choose the Welcome tab.

2. From the Home ribbon, clickOptions.

3. The Software Options dialog box displays. Choose Technical support from the left column.

4. Click Upload diagnostic report.
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5. A confirmation dialog box appears. Click Yes to upload and send the report.

6. A dialog box displays confirming the report was sent. Click Yes to dismiss the box.
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Navigating the Software
Using Ribbons

The ribbon bar runs across the top of the software. The ribbon setup shouldmake it easier for you
to navigate the software and find what you need faster. The software includes several different
tabbed ribbons that change depending on what you need.

Each ribbon contains one or more labeled sections. Each section contains a series of related but-
tons. A button may have an arrow below it. Click the arrow to select from a list of drop-down
options.

When you are working in theWelcome Tab, you can access the following ribbon: 

l Home

When you are working in your Media Library, you can access the following ribbons:

l Home
l Share
l Vault
l View

When you are editing images, you can access the following ribbons:

l Image
l Adjust
l Touchup

When you are in the Bookshelf view, you can access the following ribbons:
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l Album

When you are in the Album view, you can access the following ribbons:

l Album
l Journal

Working in the Media Library

The Media Library includes several different aspects that you can use to effectively organize your
media.

Option Explanations

Media Library
View

The Media Library is shown in the center of your screen and is accessible
from the My Media Library tab. This is where you will view your media files,
displayed as thumbnails. You can use the Timeline to view your media by
date; you can view your media via category and tag from the Organizer
panel; or you can view all media.

Organizer Panel

The Organizer panel allows you to sort your items into categories and tags.

l Categories: Categories allow you to organize your items into topics.
For instance, a category called Events may include several tags and
sub-categories. If you have used keywords when importing your
images, Keywords displays as a category.

l Tags: Tags allow you to further sort your items into more specific
topics. For example, the Events category may contain several tags,
such as Grandma's Birthday and Prom. If you have used keywords
when importing images, each keyword is listed as a tag in the Key-
words category.

Timeline

The Timeline allows you to view items by date. By setting the Timeline to
longer, you can slide the time all the way back to the 10 th century. Set-
ting the Timeline shorter allows you to view items within several weeks.
You can scroll through the months and years in either direction.

Item Properties
The Item Properties panel reveals the properties of a selected item and
allows you to view the associated categories. The Item Properties panel is
available in both the Media Library and the Album screens. Information
entered in the Tell the Story box may be transformed into a journaling box
in an album.
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Option Explanations

Work Area

Drag items from the Work Area into albums. The Share button provides
many options for the images within the Work Area, including sending to
StoryBook, adding to albums or tags, printing, exporting, e-mailing, and
creating a slide show. The Work Area is available in the Media Library and
both Album screens.

Toolbar

The toolbar is always visible in Historian , although the button change
depending on your location.

The buttons at the top of the Media Library allow you to navigate through
your items in the order viewed. For example, you may view all the items
you imported on a specific date. Then you may change your view to see all
the items within the Vacations tag. The Back button then returns you to
your original view. TheHome button returns you to your default view, as
set in the User Settings dialog box. The Print button allows you to print
the current page or view.

Help Button
TheHelp button takes you to a description of the specific area of the appli-
cation. For example, if you click the Help button on the Organizer panel,
a Help topic displays to explain the various parts of the Organizer panel.

Additionally, a large blue Help button is always available in the top right of
the application. Click this Help button to view the overall Help contents,
access the PDF user guide, and learn more about the software.

Ribbons

The ribbon bar runs across the top of the software. The ribbon setup should
make it easier for you to navigate the software and find what you need
faster. The software includes several different tabbed ribbons that change
depending on what you need.

Each ribbon contains one or more labeled sections. Each section contains a
series of related buttons. A button may have an arrow below it. Click the
arrow to select from a list of drop-down options.

When you are working in your Media Library, you can access the following
ribbons:

l File (opens a pop-upmenu)
l Home
l Share
l Vault
l View

Working in Bookshelf View

Bookshelf View includes several different aspects that you can use to effectively organize your
albums.

Option Explanations
Album
View The Bookshelf view displays the photo albums within your bookshelves. Double-click an

album with your mouse tomove to the Album View screen for editing and design.
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Option Explanations
Help
Buttons

The Help button takes you to a description of the specific area of the application. For
example, if you click the Help button on the Organizer panel, a Help topic displays to
explain the various parts of the Organizer panel.

Additionally, a large blue Help button is always available in the top right of the appli-
cation. Click this Help button to view the overall Help contents, access the PDF user
guide, and learn more about the software.

Ribbon

The ribbon bar runs across the top of the software. The ribbon setup shouldmake it eas-
ier for you to navigate the software and find what you need faster. The software
includes several different tabbed ribbons that change depending on what you need and
where you are within the application.

Each ribbon contains one or more labeled sections. Each section contains a series of
related buttons. A button may have an arrow below it. Click the arrow to select from a
list of drop-down options.

Working with Album View

Album View lets you design and organize the details and contents of each individual album.

Option Explanations
Album
Planning
View

The Album screen allows you to edit your photo albums, add and arrange journaling
boxes. Within the Album View, you may also select your Album Book layout from mul-
tiple choices.

Item Prop-
erties

The Item Properties panel reveals the properties of a selected item and allows you to
view the associated categories. The Item Properties panel is available in both the
Media Library and the Album views. Information entered in the Tell Your Story box
may be transformed into a journaling box in an album.

Work
Area

Drag items from the Work Area into albums. The Share button provides many
options for the images within the Work Area, including sending to StoryBook, adding
to albums or tags, printing, exporting, e-mailing, and creating a slide show. The Work
Area is available in the Media Library and both Album screens.

Ribbons

The ribbon bar runs across the top of the software. The ribbon setup shouldmake it
easier for you to navigate the software and find what you need faster. The software
includes several different tabbed ribbons that change depending on what you need.

Each ribbon contains one or more labeled sections. Each section contains a series of
related buttons. A button may have an arrow below it. Click the arrow to select from
a list of drop-down options.

When you are working in your album, you can access the following ribbons:

l Album
l Journal
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Working in Editing View

The Editing View includes several different aspects that you can use to effectively edit your media.

Option Explanations

Media Library View
The Editing View is shown in the center of your screen and is
accessible by double-clicking any image. You can edit andmodify
your images andmake revisions.

Item Properties
The Item Properties panel reveals the properties of a selected
item and allows you to view the associated categories. The Item
Properties panel is available in the Media Library, Editing View,
and Album screens. Information entered in the Tell the Story box
may be transformed into a journaling box in an album.

Toolbar

The toolbar is always visible in Historian , although the button
change depending on your location.

The buttons at the top of the Editing View allow you to undo,
redo, and save, as well as forward and back. Additionally, the
Home button returns you to your default view, as set in the User
Settings dialog box. The Print button allows you to print the cur-
rent page or view.

Help Button

TheHelp button takes you to a description of the specific area of
the application. For example, if you click the Help button on the
Organizer panel, a Help topic displays to explain the various parts
of the Organizer panel.

Additionally, a large blue Help button is always available in the top
right of the application. Click this Help button to view the overall
Help contents, access the PDF user guide, and learn more about
the software.

Ribbons

The ribbon bar runs across the top of the software. The ribbon
setup shouldmake it easier for you to navigate the software and
find what you need faster. The software includes several different
tabbed ribbons that change depending on what you need.

Each ribbon contains one or more labeled sections. Each section
contains a series of related buttons. A button may have an arrow
below it. Click the arrow to select from a list of drop-down options.

When you are working in the Editing View, you can access the fol-
lowing ribbons:

l File (opens a pop-upmenu)
l Image
l Adjust
l Touchup

Using the Drop-Down Arrows

Many of the features of Historian are accessible by clicking the drop-down arrows that appear when
your mouse hovers over an item.

Tip: You can also use your right mouse button to access the same pop-upmenus.
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Experiment with the drop-down arrows:

1. Select an item in the library.
2. Hold your mouse over the item and click the drop-down arrow.

3. A pop-upmenu appears.

Note: The menu changes based on the media type selected.

4. You may use the left mouse button to select an option from the menu.
5. Drop-down arrows bring upmany different menus. Experiment by clicking arrows on var-

ious media types within different parts of the application.

Using Your Right-Click Button

Many of the features of Historian are accessible by right-clicking on any item.

Tip: You can also use the drop-down arrows on each item to access the same features.

 Experiment with right-clicking:

1. Select an item in the library and right-click with your mouse.

2. A pop-upmenu appears.

Note: The menu changes based on the media type selected.
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3. You may use the left mouse button to select an option from the menu.

4. Right-clicking can bring upmany different menus. Experiment by right-clicking on different
media types and in different tabs/views.

Using Keyboard Shortcuts

There are many keyboard shortcuts in the software. As you use the application more frequently,
you'll appreciate the convenience of these shortcuts.

Shortcut Explanation
General Short-
cuts
Ctrl-A Select all
Ctrl-C Copy selected objects
Ctrl-V Paste
Ctrl-X Cut an object.
Ctrl-Z Undo an action.
Ctrl-Y Redo an action.
Ctrl-D Deselect an object when using the Selection ribbon tools.
Ctrl-S Save changes.
Home Move to the top of the list or view.
End Move to the end of the list or view.
Page up Scrolls the view up one "page". Works in most lists and image views.
Page down Scrolls the view down one "page". Works in most lists and image views.

Del Delete image.
In the Recognize Faces dialog box, this ignores the selected face.
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Shortcut Explanation
Backspace Delete image or item.
Insert In the Recognize Faces dialog box, this opens the Add New Tag dialog.

Spacebar In the Recognize Faces dialog box, this opens the menu the same as a click.
In other controls, this button acts as an alternative to the Enter button.

Enter
For non-text controls, this button often acts as a double-click or activate.
In the Archive viewer, holding the Alt key down at the same time displays
the Item Properties dialog.

Treeview Short-
cuts
Right Arrow Expands a collapsed item.

Left Arrow Collapses an expanded item.
Also will move you up a tree, collapsing items as you progress.

Up / Down
Arrows

Moves up and down through the visible items in a list. It does not expand or
collapse items.

Text Shortcuts
Ctrl-B Bold
Ctrl-I Italics
Ctrl-Left Arrow Move one word to the left.
Ctrl-Right Arrow Move one word to the right.
Page up Move to the beginning of the text.
Page down Move to the end of the text.
Home Move to the start of the line.
End Move to the end of the line.
Shift-Cursor
Positioning Keys Shift plus any of the above positioning keys will select a region.

Backspace Delete previous character.
Delete Delete current character.

Using Thumbnails

Thumbnails are small reproductions of your images that are displayedwithin Historian. You may
view several different sizes of thumbnails. You may adjust the size of your thumbnails at any time
using the slider located at the bottom of the Media Library.

Different sizes of thumbnails allow you to view different amounts of information. The largest size
takes upmore space on the screen. However, in the area around the thumbnail, you can see the
file name, image size, date taken, and rating. As the thumbnail size decreases, this information is
not displayed.

Note: To view this information for smaller thumbnails, select the thumbnail and view the Item
Properties panel.
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Large thumbnail displaying image infor-
mation

Small thumbnails without image infor-
mation

Video and audio files are represented by icons.

Audio Icon Video Icon

Viewing and Modifying Selected Items

In many cases, you will have an option to view your selected items. Click Select to review the
items you have chosen. The Select Items dialog box displays.

1. Review your selected items.
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2. Use the Add andRemove buttons to add and remove from the list.

3. When the items are correct, clickOK. You will be returned to the original dialog box.

Using the Welcome Page

TheWelcome tab is always accessible in the software. It display on launch and is a central location
where you can receive news about the product, tips and tricks, and product updates. 

The Welcome tab contains several options to help you with overall software navigation and use.

The File tab is available from every view within Historian. It changes, based on view and need, but
often includes New Vaults, Open Vaults, Printing, Importing and Sharing.

Exit and Cancel are also available on the File tab. While Cancel exits from the File tab itself, Exit
leaves and closes the application.

View the File tab.
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The Home ribbon also varies depending on the view. In the Welcome tab, the Home ribbon pro-
vides the following: 

l Various options for managing the media vault
l Quick launch of your media library
l Getting started options and tutorials
l User options

View the Home ribbon in the Welcome tab.

The Application Update and News section offers news and software updates.

Note: This function requires Internet access.

View the Application Update and News section.

The Did You Know? section provides information about Panstoria, as well as software tips and
tricks. This section is a news feed, provided by Panstoria. It will only update if you are connected to
the Internet.

Once you have viewed an item within the Did You Know? panel, you may delete it.
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Note: This function requires Internet access.

View the Did You Know? section.

Setting User Options

You can set user preferences in the User Settings dialog box.

l General Settings
l Imports
l Editing
l Metadata
l Backup
l Email
l Automatic Updates
l Spell Checking
l Technical Support

1. Select the Welcome tab.
2. From the Home Ribbon, select Options.

3. The Software Options dialog box appears. Select an option from the left column to set pref-
erences.

4. When you have adjusted the options to your liking, clickOK. Your preferences will be
adjusted accordingly.
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General Settings

Select the check boxes next to the options you want:

Options Explanations
Automatically open
the most recent
vault upon appli-
cation start

This option opens the vault you last openedwhen you start the appli-
cation.

Show low pixel warn-
ing on print

This option displays a warning if your photo has a low resolution andwill
not print well.

Use southern hemi-
sphere seasons

Select this check box if you want Historian to associate "Summer" with
December and so forth. This affects the "fuzzy dates" used in the Time-
line.

Show slide show
transition effects This shows transitions effects within your created slide shows.

Use online help
You can choose to use amore aesthetically pleasing online help file, but
you must be connected to the Internet. Without an Internet con-
nection, you can still access a more basic help file.

Allow camera import
with WIA

When you import from a camera, you can choose the basic camera
import or the WIA setting. Most newer computers support WPD, which is
a better way to communicate with cameras. If the software says no cam-
eras are available when importing from a camera, check this option.

Enable revision man-
agement

You may turn on or off revision management. If this option is selected,
the Revisions button appears in the Editors panel. To learn more about
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Options Explanations
revision management, refer to Using Revisions.

Automatically pro-
tect new revisions

This option is only available if revision management is selected. A pro-
tected image cannot be modified. Any modifications made to a protected
image will be saved to a new revision.

Minutes before auto-
matically saving
vault changes

Minutes before any changes to a vault are saved.

Reset default set-
tings This option restores the software to its original default settings.

Item property details Historian allows you to store and update metadata, or item properties.
You can choose which item property sections are visible.

Imports

Option Explanation
When images are imported,
keep the original version in
its current format.

Select this if you want to maintain
the original image file format after
import.

When images are imported,
convert the original ver-
sion to JPG format.

Select this option if you want to con-
vert TIFF, PNG, GIF, and BMP files to
the JPG format when first imported
into Historian.

Set item name from meta-
data (rather than file
name)

Select this if you want the metadata
to dictate the item name as opposed
to using the file name.

Image save quality on con-
vert or resize slider

Choose the quality in which you
want the image savedwhen you
convert it or resize it.
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Option Explanation
l Best: Largest file size with
very little loss of information

l Better: Large file size with a
minimal loss of information

l Good: Medium file size with
some noticeable distortion

Actions on import

Choose which media library view
you wish to see immediately after
import: 

l Take no action, maintain cur-
rent view

l Show all items imported
today (default)

l Show items not tagged

Show import options dialog
after paste or drop

Treat items that are drag and
dropped or pasted into Historian the
same as other imported items and
display the Import Options dialog
box.

Automatically rotate cam-
era images on import

Rotate camera images correctly
when imported into Historian. If
you have taken a portrait-style
photo, displayed by your camera as
landscape, Historian will auto-
matically correct the display. This
setting is selected when you first
install the software.
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Editing

Options Explanation

When images are edited
and saved ...

You can choose tomodify the file extension when
you edit an image.

l Save editable image revisions in JPG format
l Maintain the current format in revisions
(default)

l Prompt for the format of revisions

Image quality for edit and
save

l Maintain current image
quality

l Image quality slider

l You can choose tomaintain current image
quality when saving a new revision by ticking
the checkbox. The software will determine
the quality of the image.

l Alternatively, you can adjust the slider so that
edited images are saved as the selected image
quality.

l Best: Largest file size with very little
loss of information

l Better: Large file size with a minimal
loss of information

l Good: Medium file size with some
noticeable distortion

Initial Crop Ratio
This option allows you to set the size of the initial
crop box (crop ratio) in the Crop panel during editing.
It defaults to 4 x 6.
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Metadata

Historian 4.0 writes metadata to your vault, savingmore and detailed information about each
file. 

Metadata is "data about data." Each piece of metadata serves as a building block that tells you
more about that file. For example, an individual image may include things like the file name,
description (story), and rating.

Options Explanations

Metadata Writing: 

l Automatically write item prop-
erties to files on media vault
close

l Don't update item properties
(metadata) in original image
files

If keywords or meta-
data are already asso-
ciated with a file, it will
be includedwhen the
file is imported into
the software. Meta-
data is updatedwhen
an image is exported
outside the vault,
when the vault is
closed, or when you
manually update the
information.

l You can choose
to auto-
matically write
the new /
changed item
properties to
files whenever
a media vault is
closed.

l You can choose
to only update
revisions but
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Options Explanations
not to update
the metadata
in your original
image files in
your vault.

Metadata error handling

l Hide metadata (item properties)
update error messages

If this box is ticked,
the software will not
display errors relating
to updatingmetadata
(item properties) in
image files that are
edited.

Metadata in original
image revisions will be
preserved even if
errors occur when
attempting to update
other revisions.

Backup

1. Set the frequency of backup reminders. The system defaults to once a day, but may be
changed to less often by selecting an option from the drop-down menu.

2. Adjust reminders based on the amount of the following:
l Megabytes of unprotected data (defaults to 200)
l Items that have changes and are not protected (defaults to 100)

3. Set a full backup of everything on an annual basis.
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Email

You can add email accounts for sharing. The application automatically includes MAPI email
accounts, such as those in Microsoft Outlook. This dialog allows you to set upweb email accounts
such as Gmail, Yahoo, and Hotmail. Click Add to quickly add a web-based email account.

Notes: 

l Accounts must have an open interface to their SMTP servers. Your SMTP settings are avail-
able from your email provider.

l After editing custom settings, the software attempts to communicate with your email
server to ensure the settings work. This causes a slight delay when you clickOK. If the soft-
ware is unable to connect using the specified settings,you will be asked if you want to con-
firm the settings regardless.

Learn more about adding email accounts.

Automatic Updates
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These options control the automatic updating feature of Historian . Set the number of days
between automatic checks for updates to the software. You must be connected to the Internet to
use this feature.

If you have an update error, a dialog box will display with an error message. You can turn off this
notification in the Don't show a message box for update errors checkbox.

Note: Your computer is attempting to access the Internet to update your software. You may see a
message from your security software (such as Norton, McAfee, or Microsoft). Choose Always
Allow from the available options to allow the software to always access the Internet for software
updates and/or printing to the Web.

Available updates are also displayed in the Application News section of theWelcome tab.

Spell-Checking

These options set the default rules for spell-checking. You can set basic spelling settings that apply
to journaling boxes, telling your story, and anywhere else you may be entering text.

You can also add specific words to the default dictionary.
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1. ClickUser dictionary.
2. The User Dictionary dialog appears. Add a word in the field near the bottom of the box.

3. Click Add Word. The word is now added to your personal dictionary andwill not be flagged
asmisspelled.

Technical Support

This dialog gives you information on technical support available via the Panstoria web site. If you
talk with a customer support representative, they may ask you for a diagnostic report. A customer
service representative may also ask for your system information, which is accessible from the Sys-
tem Info... button.

If a support representative asked you to upload a diagnostic report, perform the following steps:  
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1. Click Upload diagnostic report.
2. A confirmation dialog box appears. Click Yes to upload and send the report.

3. A dialog box displays confirming the report was sent. Click Yes to dismiss the box.

40 Copyright © 2005-2013 Panstoria, Inc.



Working with Media

Working with Media
Getting Media

Working With Audio and Video
Historian 4.0 supports importing audio and video files to your Media Library. However, files do not
natively play within the software. You must have a default audio and/or video player 
(such as Windows Media Player) on your system to activate your media files. Historian only sup-
ports the files supported by your computer. For example, if your computer only has the Quicktime
movie player installed, then Memories will support only Quicktimemovies.

Click the drop-down arrows that appear as your mouse hovers over an audio or video file. A pop-up
menu appears. This menu changes depending on the media type selected. From this menu you
may access the file backup history and item information. In the following image, choosingPlay
Audiowould launch the default media player.

The Item Properties dialog boxworks the same for media files as it does for image files.

Copyright © 2005-2013 Panstoria, Inc. 41



Chapter 5

Importing From a File
If you have items stored on your computer or other location, such as a CD-ROM, a network, or an
external drive, you may also import those items into the software. Historian makes a copy of the
original file and places the copy within your Vault.

1. Select the File tab.

2. In the resulting pop-up, choose Import > From files and folders.

Note: You may also choose the appropriate button from the Get Media section of the Home ribbon.
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3. The Select Items to Import dialog box displays. Navigate to and select the images you would like
to import. You can select all or use the CTRL key on your keyboard to select individual photos. 

View dialog box.

Tip: Select several items in a row by clicking the first item, pressing the SHIFT key on your key-
board, and clicking the last item in the sequence.

4. Set your importing options in the Import Options dialog box. (If you are working in Windows XP,
this dialog box will display after you click OK.)

View dialog box.

The Import Options dialog box gives you options for the following: 
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l Renaming files on import
l Automatic tagging of imported items
l Automatically excluding all duplicate images
(For more information on duplicates, refer to Importing Duplicate Images.)

l Automatically running facial recognition on all imported images
(For more information on facial recognition, refer to Scan for Faces on Import.)

5. Click theOpen to import your selected images. The files are imported into your Vault.

6. The Media Library displays your imported images.

Note: After items have been imported, Historian automatically changes the timeline to the Import
date view with today's date selected. This allows you to easily view the items you just imported.
You can return to the previous view by clicking the back arrow button in the media library title bar
or by clicking on the Home button in the ribbon.

Importing From Your Camera
You may import images directly into Historian from your camera. Historian copies the images on
your camera into your media vault.

Note: Importing to Historian does not remove items from your camera. Imported items remain on
your camera unless you specifically delete them using the Delete button on your keyboard or you
delete the images using features on your camera.

1. Select the File tab.

2. In the resulting pop-up, choose Import > From a camera or card reader.
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Note: You may also choose the appropriate button from the Get Media section of the Home ribbon.

3. If more than one camera drive is detected, the Select Camera dialog box displays. Choose your
camera and click Select.

Note: If you are using aWIA camera, you will first see aWIA-import dialog box before continuing
with your import.

View dialog box.

4. The Get Pictures from Camera dialog box displays. Select the photos you want to import. You
can select all or use the CTRL key on your keyboard to select individual photos.
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Tip: Select several items in a row by clicking the first item, pressing the SHIFT key on your key-
board, and clicking the last item in the sequence. You can exclude duplicates, exclude the pre-
viewed image, and rotate the images using the buttons under the preview.

You can also exclude or include specific items by using the drop-down arrow or right-clicking on
each thumbnail.

View dialog box.
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5. Set your importing options in the Import Options dialog box. (If you are working in Windows XP,
this dialog box will display after you click OK.)

View dialog box.

The Import Options dialog box gives you options for the following: 

l Renaming files on import
l Automatic tagging of imported items
l Automatically excluding all duplicate images
(For more information on duplicates, refer to Importing Duplicate Images.)

l Automatically running facial recognition on all imported images
(For more information on facial recognition, refer to Scan for Faces on Import.)

6. Click the Import All or Import Selected to import your selected images. The files are
imported into your Vault.

7. The Media Library displays your imported images.

Note: After items have been imported, Historian automatically changes the timeline to the Import
date view with today's date selected. This allows you to easily view the items you just imported.
You can return to the previous view by clicking the back arrow button in the media library title bar
or by clicking on the Home button in the ribbon.
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Importing From Social Media
If you have items stored on your computer or other location, such as a CD-ROM, a network, or an
external drive, you may also import those items into the software. Historian makes a copy of the
original file and places the copy within your Vault.

1. Select the File tab.

2. In the resulting pop-up, choose Import > choose Flickr, Facebook, or Picasa.

Note: You may also choose the appropriate button from the Get Media section of the Home ribbon.

3. Log into the social media site. If you haven't already, you will be required to authorize Historian
to access your account.

Note: Privacy settings on social media sites override Historian access. You will be able to access
your own images, and those of your friends, only if your site settings allow access from outside
applications.

4. The Get Photos from ... dialog box displays. Navigate to and select the images you would like to
import. You can select all or use the CTRL key on your keyboard to select individual photos. 

5. The Import Options dialog box displays.

View dialog box and options.

The Import Options dialog box gives you options for the following: 

l Renaming files on import
l Automatic tagging of imported items
l Automatically excluding all duplicate images
(For more information on duplicates, refer to Importing Duplicate Images.)

l Automatically running facial recognition on all imported images
(For more information on facial recognition, refer to Scan for Faces on Import.)
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6. The files are imported into your vault and the Media Library displays your imported images.

Note: After items have been imported, Historian automatically changes the timeline to the Import
date view with today's date selected. This allows you to easily view the items you just imported.
You can return to the previous view by clicking the back arrow button in the media library title bar
or by clicking on the Home button in the ribbon.

Importing From Your Scanner
You may import images directly from your scanner. Your scanner must be connected to your com-
puter to import. Scanning is a great way to preserve old photos, newspaper clippings, and draw-
ings.

Tip: If you own a high-end scanner, you may want to use the software that accompanied the
scanner. High-end scanning software offers more complex options. You may then import the
image into Historian by using Importing from a file.

1. Select the File tab.

2. In the resulting pop-up, choose Import > From a scanner.

Note: You may also choose the appropriate button from the Get Media section of the Home ribbon.
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3. The Scan Using ... dialog box opens. Select the option for the type of photo you wish to scan.

Tip: You may adjust the quality of the scanned images by clickingAdjust the quality of the
scanned image. The Advanced Properties dialog box lets you adjust contrast, brightness, res-
olution, and type of photo. 

4. Click Scan. The scanner will preview the items you wish to scan.

5. Once you are satisfied with the preview, click Import.
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6. The images will be scanned and appear in the Loading Scanned Images dialog box.

7. You may import the entire image or import selected portions of the image.

l To import the entire image, continue to Import the Entire Image.
l To import selected portions of the image, continue to Import Selected Areas.

Import the Entire Image

1. In the Loading Scanned Images dialog box, click the radio button for Import entire image.
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2. Click Import. Historian imports the image.

3. The software displays a message confirming the import.

Import Selected Areas

1. In the Loading Scanned Images dialog box, click the radio button for Import selected area.

2. Arrange the selection box on the portion of the image you wish to import.
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3. Click Import. Historian imports the image.

4. The software displays a message confirming the import.

Searching for Media Files
If you have files stored on your computer or on a network or external drive, you may also import
those items into Historian . The software makes a copy of the original item and places the copy
within your media vault. If you are unsure where the items are stored,Historian will help you
search your computer.

1. Select the File tab.

2. In the resulting pop-up, choose Import > Search the computer.

Note: You may also choose the appropriate button from the Get Media section of the Home ribbon.
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3. TheMedia File Search dialog box appears. Select the drive and path you want to search. The box
defaults to your C:\ drive, which is usually the main hard drive. If you have more than one hard
drive in your machine, you may select the drive letter from the drop-down menu. You may also
browse to a specific path by clicking the Browse button.

4. Select the file size for which you want to search. The default is 500 KB (kilobytes). Click Start
Search.

5. Historian searches your machine for media files that match the criteria selected. When the
search is complete, the Get Media Items From Search Results dialog box displays.
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6. The available items display. Hold your mouse over each icon to view the file names.

Notes:

l Appropriate icons display as thumbnails for audio and video files. File names are revealed
when your mouse hovers over the icon.

l The folders that include possible items will display a green open tag icon. Review each of
these items carefully in the thumbnail viewer of the dialog box. It is possible that the search
will have turned upWindows backgrounds and other miscellaneous items, as well as legit-
imate media.

Tips:

l You may switch between thumbnail and list view by clicking the icons in the right corner of

the dialog box.
l Items already included in your Media Library are marked as duplicates in the Get Media
Items ... dialog box.

View example.

Tips:

l Select several items in a row by clicking the first item, holding down the SHIFT key on your
keyboard, and clicking the last item in the sequence.

l Set your importing options in the Import Options dialog box.

View dialog box.

The Import Options dialog box gives you options for the following: 
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l Renaming files on import
l Automatic tagging of imported items
l Automatically excluding all duplicate images
l Automatically running facial recognition on all imported images

7. Select the items you wish to import into Historian . You may select more than one item by hold-
ing down the CTRL key on your keyboard. ClickGet Selected Items. If you want to import all the
items, clickGet All Media Items.

8. The files are imported into your vault. The Media Library displays your imported images.

Note: After items have been imported, Historian automatically changes the timeline to the Import
date view with today's date selected. This allows you to easily view the items you just imported.
You can return to the previous view by clicking the back arrow button in the media library title bar
or by clicking on the Home button in the ribbon.

Working with Keywords On Import
When you import images that are already taggedwith identifying keywords, you have the option
of creating tags based on those keywords.

1. Historian detects the keywords on import and displays the Process Tagged Images dialog box.
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2. Deselect a checkbox if you do not want to convert that keyword to a tag. ChooseDeselect all if
you do not want to use keywords as tags.

3. You can change which tag the keywords are associated with by selectingChange.

4. You can view the images associated with the keywords by choosingView.

5. ClickOK to create tags from pre-assigned keywords. The Organizer Panel displays a category
calledKeywords found in images.
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Organizing Media

Working With Categories
Categories are the first level of organization definedwithin the Organizer panel. You can create
tags and sub-categories within a category. In this example, Sports is a category.

Tip: In previous versions of Historian, categories were referred to as sort boxes and tags were
referred to as folders.

Note: You must create a tag within a category. You cannot import directly into a category.

Sub-categories are an additional level of organization definedwithin the Organizer panel. You are
not required to use sub-categories. You can create tags within both sub-categories and top-level
categories. In this example,Baseball is the sub-category with the main Sports category. 
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Note: You must create a tag within a category. You cannot import directly into a category at any
level.

Learn more about:

l Adding a Category
l Editing a Category
l Deleting a Category

Adding a Category

Perform the following steps to create a new category:

1. Click the arrow to the right of the My Categories option. A pop-upmenu displays.

2. Select Create Category from the menu. The Create a new category dialog box appears.
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3. Enter a new name for your category.
4. From the Parent Category drop-down list, selectMy Categories if you want to create a top-

level category. Select another category to create a sub-category.
5. ClickOK. A new category appears within the list.

Editing a Category

Perform the following steps to edit a category:

1. Click the arrow to the right of the category or sub-category you wish to edit. A pop-upmenu
appears.

2. SelectProperties from the menu. TheCategory Properties dialog box appears.
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3. Edit the name and location of your category.
4. ClickOK. The category has been updated.

Deleting a Category

Perform the following steps to delete a category:

1. Hold your mouse over the category and click the drop-down arrow. A pop-upmenu appears.

2. Select Delete from the menu. A dialog box appears asking you to confirm.
3. Click Yes.
4. The category is removed from the list.

Working With Tags

Tags are the most specific level of organization definedwithin the Organizer panel. Tags can be
created within sub-categories as well as top-level categories. However, you do not have to create a
tag inside a category at all. A tagmay stand on its own inside the top-level category.

Tip: In previous versions of Historian, categories were referred to as sort boxes and tags were
referred to as folders.
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Learn more about:

l Adding a Tag
l Editing a Tag
l Deleting a Tags

Note: Face tags, identified during facial recognition, function in the same way as regular tags but
show a different icon.

Adding a Tag

Perform the following steps to create a new tag:

1. Click the arrow next to a category. A pop-upmenu appears.

2. Select Create Tag from the menu. The Create a new tag dialog appears.
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3. Enter a name for your new tag.
4. Select a location for your tag from the Category drop-down list. To create a standalone tag,

select My Categories.
5. Click >OK. A new tag appears.
6. You may drag the tag to any location you wish in the Organizer panel.

Editing a Tag

Perform the following steps to edit a tag:

1. Click the arrow to the right of the tag. A pop-upmenu appears.

2. Select Properties from the menu. The Tag Properties dialog box appears.
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3. The Edit a tag dialog box provides the following options:
l Tag Name: Edit the name of the tag
l Located in this category: Change the category with which the tag is associated.
You may move the tag out of any category by selectingMy Categories.

l Remove: Select a thumbnail in the dialog and click this button to remove the item
from this tag.

Note: Removing an item from a tag does not delete it from your library. If the removed
item is not associated with any other tag, this item will be found in Not in any tag.

4. Perform the necessary action(s) and clickOK. The tag will update.

Deleting a Tag

Perform the following steps to delete a tag:

1. Hold your mouse over the tag and click the drop-down arrow. A pop-upmenu appears.
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2. Select Deletefrom the menu. A dialog box appears asking you to confirm.
3. ClickYes.
4. The tag is removed from the list.

Note: Removing a tag does not delete the items within the tag. If the items are not associated
with other tags, the items will be found in Not in any tag.

Adding and Removing Items Within Tags
There are several ways to add items to tags.

l Drag and drop
l Add an Item Using Drop-Down Arrows (Add tomultiple tags)

You may also remove items from a tag using the drop-down arrows.

Drag and Drop

When you import your items, they default to a category calledNot tagged in the Organizer panel.
If you want to assign new categories and tags to your items, perform the following steps:

Tip:You may drag and drop from any tag in your Media Library.

1. Select Not in any tag to view your untagged items.
2. Select the first item you wish tomove.

Tip: You maymovemultiple items by pressing the CTRL key on your keyboard and select-
ing each item. To select all displayed items, press CTRL-A on your keyboard.

3. Hold down your left mouse button and drag the item(s) to the new tag. A square icon
appears when your mouse enters the Organizer panel.

4. A yellow highlight will appear around the tag when your mouse is in the right place. Release
the mouse button.
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5. A confirmation message will appear.
6. Select the new tag. Your item(s) will display.

Add an Item Using the Drop-Down Arrows

You may also add items to tags using the drop-down arrows. This method allows you to addmedia
to more than one tag at a time.

1. Select an item in your Media Library.
2. Hold your mouse over the item and click the drop-down arrow. A pop-upmenu appears.
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3. Select Tag with. The Add items dialog box displays.

4. Click the appropriate tags. Hold the CTRL key to select more than one tag.
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5. Click Add. Your item may be displayed by selecting the appropriate tags from the Organizer
panel.

Remove Media From a Tag

You may removemedia from a tag using the drop-down arrows. Perform the following steps:

1. Select an item or group of items in your Media Library.
2. Click the drop-down arrow. A pop-upmenu appears.

3. Select Remove from a tag. The Remove from a tag dialog box displays.
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4. Select the tag that you want to remove.
5. Click Remove. Your item will be removed from the selected tag.

Using Ratings

Ratings are another option for sorting and organizing your items. You can rate an item on a scale of
one to five stars, with five stars being the highest rating. You can then view your items by how
many stars are assigned.

l Assigning Ratings
l Viewing items Based on Ratings

Assigning Ratings

There are two ways to assign ratings. You may assign a rating in the Item Properties panel or by
using the drop-down arrows.

To assign a rating in the Item Properties panel, perform the following steps:

1. Select an item within the library. Selected items are highlighted in gray.

2. The properties of the item will appear in the Item Properties panel. Click the rating level you
wish to assign to the item by selecting a star.

3. The appropriate number of stars appear below the item.
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To assign a rating using the drop-down arrows, perform the following steps:

1. In the Media Library, hold your mouse over an item and click the drop-down arrow. A pop-up
menu appears.

2. From the resultingmenu, select Ratings.

3. From the Ratings sub-menu, choose the level of rating, from one to five stars, that you want to
assign the item.

4. The appropriate number of stars appear below the item.

Viewing Media Based on Ratings

To view your media based on ratings, perform the following steps:

1. The Ratings Selection tool is located at the top of the Organizer panel.
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2. Click the number of stars and choose from the pop-upmenu:

l Number of stars and higher
l Number of stars and lower
l Number of stars only

3. Items that meet your criteria display in the Media Library.

Tip: You may set the rating level as a default in the User Settings dialog box.

Copying to Windows from the Organizer Panel
You can copy your files to Windows from the various levels of organization within the Organizer
Panel. To export to Windows, perform the following steps:

1. In the Organizer panel, click on the Media Library or a category drop-down arrow and choose any
of the following:

Options Explanation

Copy the vault, categories
and tags to Windows
tags: Copies the contents of
your entire media library to a tag
in Windows.

Select My Media Library and click the drop-down menu. Select
Copy the vault, categories and tags to Windows tags.

View dialog.

Export from Category:
Exports only the contents of the
selected category, including all
tags and sub-categories

Select a category and click the drop-down menu. Select Copy
category and tags to Windows tags.
View dialog.
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Options Explanation

2. The Copy ToWindows dialog box displays. Enter the information and clickOK.

View the dialog box and options.

Options Description

Destination: Copy to this Windows Folder

You can manually
enter the path or
use Browse to
find the exact
location where
you want to copy
the files.
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Options Description
Note: Make sure
you select an
empty folder to
receive the cop-
ied files.

Item Selection: 

l Copy all items in Places
l Copy items only if currently showing in Media library

You can choose
to copy based on
view. For
instance, if you're
copying items in
the Places tags,
but you're only
displaying those
from 1965, you
can choose to
copy that select
number of
images.

Items with multiple tags

l Save single copy and use shortcuts in other Windows folders
l Save a copy in each Windows folder

This is applicable
when copying
your entire media
library. You can
choose to have
multiple copies of
an image, or one
version plus short-
cuts.

Note: If you
move the image,
the shortcuts will
be invalidated.

File naming

l Same as the current filename
l Same as the name shown in Item Properties

You may have
renamed a file in
Item Properties.
For example, you
may have
renamed
DSC1918.jpg to
Evening with my
Sister. You can
choose to use the
new name or the
original file name.

Revisions

l Copy all revisions
l Copy only the currently displayed revision

If you have made
multiple
revisions, you
choose to copy all
of the revisions or
only the dis-
played revision.
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3. The items are copied and you can access them directly from Windows.

Working with Time

Working With Time

Using dates and the Timeline allowsmany options for organizing your media. Time is an additional
organizational tool, allowing you to drill further down into your categories and tags.

The Timeline is located at the bottom of the Media Library. The Timeline may be adjusted to go
back several centuries. When you are organizing your items, you can assign dates. You may
choose to assign a date that the item was created. However, you might also wish to assign a date
to the object in the item. For instance, if you had an image of the U.S. Declaration of Inde-
pendence, you might choose to assign a date of July 4, 1776. Once you have assigned a date, you
may then view your items based on time.

Clicking anywhere on the Timeline will display items assigned dates from that particular period of
time. For example, clicking on the year 2006 displays only items assigned dates within that year. 

The small gray boxes on the top of the scale indicate a percentage of items in the range. In this
example, there are more items in 2012 and only a few items in 2009.

You may adjust the sliders on the Timeline by clicking on the Timeline and dragging the yellow
markers. The Media Library will display items in the selected range. If you click on a specific point in
the Timeline, the Media Library will display only items from that particular date. If there are no
items on that date, the Media Library displays a "No Matching Items" message.

Timeline Options

Click>> on the left side of the timeline to display options.

l When you first import items into Historian , they display by Date Imported. To view media
by the date assigned to each file, click the Media button.

l You may adjust the size of the Timeline to display decades or individual days of the month.
To adjust the size of the Timeline, use the slider in the lower left corner.

Filtering Media with Time

Using dates and the Timeline allowsmany options for organizing your media. Time is an additional
organizational tool, allowing you to drill further down into your categories and tags. You can filter
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your media using the Timeline. Apply a filter to your media. You can choose to filter by Tag, Cat-
egory, Rating or any combination.

Learn more about filtering your media.

In this example, we have filtered our Media Library by a rating of 3 Stars and above.

Notice that the timeline displays a filled in portion as well as an outline portion.

The filled in, or grey, portion of the block represents the items in your filter.

The empty, outlined portion represents your Media Library as a whole.

In the above example, the following is true: 

l All the photos from 2001 - 2004 are markedwith 3 stars or higher.
l A portion of the photos in 2005 and 2006 are markedwith 3 stars or higher.
l No photos in 2007 are markedwith 3 stars or higher.

Sizing the Timeline

You may adjust the size of the Timeline to display decades or individual days of the month. To
adjust the size of the Timeline, use the slider in the Timeline Options window, accessible from the
>> symbol.

Assigning Dates

You may assign dates and times to an item. Several different options are available for assigning
dates, from specific to fuzzy. Months can be specified by number, accepted abbreviations, or full
name.

Notes:

l Only English spellings are currently supported.
l Dates are not case sensitive.
l Dates do not require punctuation, although it is accepted.
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l You may enter hours, dates, and seconds. The system converts all time to a 24-hour
clock.

l A single date includes all 24 hours of that date.
l You may set southern hemisphere seasons in the Options dialog box. 
l You may enter fuzzy dates, as shown in the following example.

Examples:

Date entered: System-assigned date
1/14/72 or 1/14/1972 January 14, 1972
August 30, 2003 August 30, 2003
Aug 30, 2003 August 30, 2003
1/14/72 3:00 PM January 14, 1972, 15:00

hours
12/2004 December 1 - 31, 2004
December 2004 December 1 - 31, 2004
winter of 1993 12/1/1992 through

3/31/1993
October 1985 October 1985
Circa May 2001 May 2001
spring 1956 3/1/1956 through

6/30/1956
summer '69 5/15/1969 through

9/30/1969
autumn (or fall) 1942 9/1/1942 thorough

11/30/1942
early 1977 1/1/1977 through

6/30/1977
late 1933 7/1/1933 through

12/31/1933

Although the system is assigning a location in the timeline to your item based on the date you
entered, the text of the date you entered remains the same.

Example: If you enter Summer of '69 into the Item Properties panel, you will continue to see
Summer of '69 in the panel whenever you view that item. However, you will also be able to pull up
the item on the timeline between May 15, 1969 and September 30, 1969.

When you first import items into Historian , they display by Date Imported. To view media by the
date assigned to each file, click the Media button in the Timeline Options.

To assign a date to an item, perform the following steps:

1. Select the item in the Media Library.

2. Click the Item Properties panel.

3. Add or change the date listed in the Date field. If you are unsure of a date, use a "fuzzy" date, as
in the examples above.

76 Copyright © 2005-2013 Panstoria, Inc.



Working with Media

4. Click on the item again to confirm the change. If you are viewing larger thumbnails, you will
notice the date change in the left corner of the thumbnail.

Searching With the Timeline

You can use the Timeline to search for specific media.

1. Choose>> on the Timeline to open the Timeline Options.

2. ClickMore.

3. The Select dates dialog box displays. Enter the following information:
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Options Description

Date Range
Select a range of dates, as small
as a holiday or as large as All
Dates.

Custom Dates

View the Custom Date options.

Within date range, you can also
enter a Custom Date. You can
specify dates such as
1/14/1972, August 30, 2003,
early 1977, and so on. For more
information on Custom Dates,
refer to Assigning Dates.
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Options Description

Date Type

You can choose the date the
media was captured or assigned
(Media Date) or the date the
media was imported.

Select a Month Choose amonth within any
year.

Use All Dates checkbox

Selecting this box controls the
histogram displayed under the
year andmonth options. When
unchecked, only those items in
the current view are rep-
resented.

4. The Media Library displays items from the date you specified.

Displaying Media

Displaying Media

After you have set up categories and tags in the Organizer panel, you can sort and display your
memories in several different ways. For more information on categories and tags, refer to Working
with Categories andWorking with Tags.
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l Display by Category
l Display by Tags
l DisplayingMultiple Tags

Display by Category

Using the Organizer panel, you can sort your memories based on category. In the example shown
here, all items within the Family category are displayed, because the Family category is selected.

Display by Tag

Using the Organizer panel, you can sort your memories based on tag or category. In the example
shown here, only images of Mom are displayed, because the Mom tag is selected.

Displaying Multiple Tags

You may want to display multiple tags. For instance, you may want to display all the photos within
the San Antonio and Austin tags. Alternatively, you may want to display only the items assigned to
both of the tags. You can hold the CTRL key on your keyboard and select multiple tags. However,
there are other options as well.

To view all items in two or more tags, perform the following steps:

1. Click a tag in the Organizer panel to select it.
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2. Hold your mouse over the tag you wish to display in addition to the first tag and click the drop-
down arrow.

3. A pop-upmenu displays. Select Display items having this tag in addition to those now displayed.

4. Both tags display as highlighted and all items from both tags are displayed.

5. You may continue to display additional tags in the samemanner.

To view only the items assigned to two of more tags, perform the following steps:

1. Click a tag in the Organizer panel to select it.

2. Hold your mouse over a second tag and click the drop-down arrow.

3. A popup menu displays. Select Display items having both this tag and those now displayed.

4. Both tags display as highlighted and only the items assigned to both tags are displayed.

5. You may continue to display additional items in the samemanner.

Displaying Media with Views Options
Many sorting and viewing options within the Media Library are available from the Home ribbon.

The View section includes several options: 
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Option Description
All The All Options displays all contents of your Media Library.

Home

The Home view is set in the Vault Properties dialog box. You can
access Vault Properties by setting File > Properties.

Note: This view is defined on an individual vault basis and
defaults toAll.

Preview

View the Preview down-down
menu

The Preview button includes a drop-down list allowing you to
customize your images.

l Show image preview: Double-clicking an image dis-
plays a large, zoomable preview.

l Show image preview with faces: Double clicking an
image displays a large, zoomable image and displays iden-
tified face tags on the image.

View example.

Note: From this view, you may also add face tags to images
with unidentified faces. Fore more information, refer to Add
Missing Faces Using Preview.

l Close image preview closes the preview screen.

Displaying Media Using Find Options
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Within the Media Library, you can find and display your media in several simple ways using options
in the Find section of the Home ribbon.

Options Description
Faces

View the Faces drop-down menu.

This option sorts and displays information
based on facial recognition. Choose from
your existing face tags to display images
based on person.

Note: This option is only available if facial
recognition is available in the vault. To
learn more, refer to Turn on Facial Rec-
ognition.

Ratings

View the Ratings drop-down menu.

To sort by ratings, click Ratings and
select a sorting option from the drop-
down menu. You can then view media
files strictly by the number of stars
applied.

Media Types

View the Media Types drop-down menu.

To sort by specific type, clickMedia Types
and select the specific media type you
would like to display.
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Options Description

Print Track

View the PrintTrack drop-down menu.
Whenever you print, Historian asks if you
would like to mark those images as
printed. Using the PrintTrack option,
you can choose to display images that are
printed, marked for print, or have not yet
been printed.

Search

View the Search dialog box.

Choose your preferred search method
(Name, Tell the Story, or both) and the
text location. You may also choose to
match the case. Choose where to search,
whether in the current display or the
entire vault.

Media that meets your search criteria will
display.

Dates
For more information, refer to Using Date
Views

Displaying Media Based on Ratings

You can view your media based on ratings, categories, and tags. After you have set up categories
and tags, you can sort and display your memories in several different ways. For more information
on categories and tags, refer to Working with Categories andWorking with Tags. To learn more
about assigning ratings, refer to Using Ratings.

In the example shown here, Ratings has been set to 3 stars and higher and the Beaches tag
has been selected. Historian will therefore display any media within the Beaches tag rated with
three stars or more.
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Filtering Media with Time
Using dates and the Timeline allowsmany options for organizing your media. Time is an additional
organizational tool, allowing you to drill further down into your categories and tags.

Learn more about Timeline options.

You can filter your media using the Timeline. Apply a filter to your media. You can choose to filter
by Tag, Category, Rating or any combination.

Learn more about filtering your media.

In this example, we have filtered our Media Library by a rating of 3 Stars and above.

Notice that the timeline displays a filled in portion as well as an outline portion.

The filled in, or grey, portion of the block represents the items in your filter.

The empty, outlined portion represents your Media Library as a whole.

In the above example, the following is true: 

Copyright © 2005-2013 Panstoria, Inc. 85



Chapter 5

l All the photos from 2001 - 2004 are markedwith 3 stars or higher.
l A portion of the photos in 2005 and 2006 are markedwith 3 stars or higher.
l No photos in 2007 are markedwith 3 stars or higher.

Using Date Views
When you import new media, Historian displays the Import Date view. The first time this happens,
a message box displays. ClickDon't show this again to hide this message on future imports.

The Import Date view shows only the items imported on the current date, and is denoted on the
Timeline.

You can also view images by Import Date whenever you like. Click Dates in the Find section of the
Home ribbon and select a date from the Select Dates dialog box.
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Options Description

Date Range
Select a range of dates, as small
as a holiday or as large as All
Dates.

Custom Dates

View the Custom Date options.

Within date range, you can also
enter a Custom Date. You can
specific dates such as
1/14/1972, August 30, 2003,
sometime in 1972, and so on.
For more information on Custom
Dates, refer to Assigning Dates.
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Options Description

Date Type

You can choose the date the
media was captured or assigned
(Media Date) or the date the
media was imported.

Select a Month Choose amonth within any
year.

Displaying Home View
You can customize the view that displays when you click the Home button in the View section.

To customize the Home view, perform the following steps:

1. Select the filters you want in the Media Library.
For example, choose the Category and/or Tag you would like to use, as well as any Ratings filters.

2. Press and hold theHome button in the View section.
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3. A confirmation dialog box displays. ClickOK.

4. Go to File > Properties to open themedia vault properties dialog box.

5. Select General. In the General properties section, you can adjust the dates shown in the Home
view and your start view.
Learn more about these settings.

6. Complete these steps again to reset the Home view at any time.

Viewing Item Details
Within the Media Library, the View ribbon provides options for sorting and viewing items.

You can apply a view, such as Date view, a Category view or a Timeline-based view, and then sort
within those displays using the View ribbon. You can also apply the View ribbon features to your
entire library.

You can view the details of the items within your library by using the Details panel of the View rib-
bon.

Option Description

Clear
Clear removes all details from the items within your library.

View example.
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Option Description

Basic

Basic displays only the name of the image.

View example.

Detailed

Detailed showsmore item information, including name,media date, and
ratings.

View example.
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Option Description

Custom

The Custom item displays a dialog box. Click the checkboxes next to what
details you want to display for the items in your library.

View dialog box.

Specific Sorting
Within the Media Library, the View ribbon provides options for sorting and viewing items.
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You can apply a view, such as Date view, a Category view or a Timeline-based view, and then sort
within those displays using the View ribbon. You can also apply the View ribbon features to your
entire library.

You can view the arrange items within your library by using the Sort panel of the View ribbon.

Option Description
Name Sort by item name within the library.
Ratings Sort by number of ratings.

Media Date Sort by Media Date, which is the date assigned to the
image, such as Christmas 1970.

Import Date Sort by Import Date, which is the date the item was
imported to Historian.

Ascending Sorts your chosen selection A-Z.
Descending Sorts your chosen selection Z-A.

Zooming
Within the Media Library, the View ribbon provides options for sorting and viewing items.

You can apply a view, such as Date view, a Category view or a Timeline-based view, and then sort
within those displays using the View ribbon. You can also apply the View ribbon features to your
entire library.

You can view the details of the items within your library by using the Details panel of the View rib-
bon.
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You can zoom in and out on your photos.

l Click Zoom Inmultiple times. Each time you click, the thumbnails in your library enlarge.
l Click Zoom Out to shrink your image one size per click.

Accessing Item Information

Every digital item has information associated with it. This information may include file type, size,
resolution, type of camera used, lighting, exposure, andmore. If you are interested in viewing this
information, you may access it via the Item Information option.

To view the item information, perform the following steps:

1. Select the item for which you want to view information.

2. Hold your mouse over the item and click the drop-down arrows. A pop-up menu appears.

3. Select Image Properties from the menu. The Image Information window appears. Select the
appropriate tab to learn more about the item.

Note: The menu changes based on the file type. For video files, select Video Information. For
audio files, select Audio Information.

Options Explanation

Overview

The Overview section offers
the following sections:

l Image
information: Offers
pixel size, such as
1800 x 1200
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Options Explanation
l Item
information: This
gives general infor-
mation, often from the
Item Properties panel
These items include
Name, ItemID if avail-
able, Description,
Media date, Import
date, and Original
date, Original File
name, Keywords,
Health status within
the vault, Saved pixel
size and print status
status.

l File: This section pro-
vides basic file infor-
mation, including type
(JPG, PNG, etc), File-
name and path, File
size, date created and
last date modified.

Backup Status

The Backup Status section dis-
plays when the item was last
backed up, what type of
backup, how many item prop-
erty updates are pending, if a
shadow copy exists, and the
device (DVD, external drive,
etc) to which the item was
last saved.

Common Metadata

Common metadata includes
common information
appended to the image and
only includes items that have
been written to the item file
(not pending). For more infor-
mation, refer to Writing
Image Properties (Metadata)

l Description: Basic
item information
including title, descrip-
tion (Tell Your Story),
Rating, and Keywords.
Much of this is also
available in the Over-
view option.

l Copyright: If copy-
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Options Explanation
right information has
been written to the
item, it displays here,
including author and
copyright notice.

l Location: Newer cam-
eras often record
GPS information as
metadata in an image.
If the latitude, lon-
gitude, and other GPS
information is avail-
able, it will display
here.

l Camera
data: Standard cam-
era data is recorded in
this section, including
camera manufacturer
andmodel, exposure,
flash, light source,
aperture andmore.

Raw Metadata

Truly raw metadata recorded
from a camera is listed here.
Sections include the
following: 

l EXIF
l XMP
l IPTC

4.When you are finished viewing, click Close to close the window.

Modifying Item Properties

Item details include the name of the image, the date the item was created, ratings, stories about
the item, and tags in which the item is located.

1. Select an item within the Media Library or an Album. Selected items are highlighted in gray.

2. The properties of the item display in the Item Properties panel. You may modify the name of the
item and the date the item was created.
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3. The Item Properties panel also shows the tags, if any, to which the item belongs. Right-click on a
tag to remove its association with the item.

4. Once you have made changes to the Image Properties panel, click Save at the bottom of the
panel to retain the changes or Cancel to remove them.

Deleting an Item

Occasionally you may wish to remove an item from your vault. It is important to realize that you
are deleting the item from the actual vault and it will no longer be available for printing, albums, or
other activities. However, if you delete an item on the Album Planning screen, you are deleting the
item only from the current album. The item still exists in the vault.

l Delete From a Vault
l Delete While Editing
l Delete From an Album

Delete an Item From a Vault
To delete an image from amedia vault, perform the following steps:

1. Select the item(s) you wish to remove.

2. Hold your mouse over the item and click the drop-down arrow. A pop-upmenu appears.

3. Select Delete from Vault.
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Note: You may also use the DEL button on your keyboard to delete an image from your Media
Library.

4. A confirmation box appears, asking if you are sure you want to delete the item. If you are sure
you want to delete, click Yes. If you change you mind, clickNo or Cancel.

Note: If you are deleting a series of images and change your mind, selectingNowill keep from
deleting the single image but you will have tomake the same decision for the rest of the images in
the series. Cancelwill end the entire action and no items will be deleted.

5. The item is moved to the vault's recycle bin. You can still recover the image by using the Vault
ribbon in the Media Library.

Delete While Editing
You can delete an item while in Editing view.

1. Hit the DEL key on your keyboard.

2. A confirmation message appears. Confirm the deletion.

3. The image is removed to the vault's recycle bin.

Delete an Item From an Album
To delete an item from an album, perform the following steps:

1. Select the item(s) you wish to remove.

2. Hold your mouse over the item and click the drop-down arrow. A pop-upmenu appears.

3. Select Remove from Album. A confirmation box appears, asking if you are sure you want to
delete the item.

4. If you are sure you want to delete, click Yes. If you change you mind, click No or Cancel.

Note: If you are deleting a series of items and change your mind,Nowill keep from deleting the
single item but you will have tomake the same decision for the rest of the items in the series. Can-
cel will end the entire action and no items will be deleted.

5. The item is removed from the album but remains available in the Media Library.

Accessing Backup History

You can view the backup history of an item to learn when the item was backed up, the backup ID,
and backup device.

To view the backup history, perform the following steps:

1. Select the item for which you want to view information.

2. Hold your mouse over the item and click the drop-down arrow. A popup menu appears.

3. Select Image Properties from the menu. The Image Information window appears.
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Note: The menu changes based on the file type. For video files, select Video Information. For
audio files, select Audio Information.

4. Select the Backup Status option. The backup history and associated details display.

View the dialog box.

5.When you are finished viewing, click Close to close the window.
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Using Facial Recognition
Overview of Facial Recognition

Facial recognition helps you find and name the photos of your friends and family. Once you enable
facial recognition, you can set up Historian to automatically identify the people you import as well
as scan your entire existing library.

To quickly get started with facial recognition:

l Turn on Facial Recognition
l Automatically Scan for Faces

Understanding Facial Recognition
Facial recognition is a feature that helps you group photos based on particular people. After you
identify someone in a photo (by naming the person), Historian uses face-recognition technology to
help you find other photos that include that person. Historian suggests more photos that may con-
tain the same person, you confirm the matches, and the software groups those matched photos
under the person’s name.

Face Tags
When you initially name a person, you are creating a face tag. A face tag functions just like a reg-
ular tag. It resides inside categories and can be moved, renamed and deleted. (Refer to Working
with Tags.) Face tags are denoted in the Organizer panel with a person icon.

In this example, the face tags have been placed in a People category.

When you initially create a face tag, you are creating a reference image. This first image is what His-
torian uses to identify subsequent instances of that face in your library. Every time you identify
that person, the new image is added as an additional reference face. The more reference faces per
face tag, the more accurate Historian can be.

If Historian is consistently missing the face, consider choosing a different reference face. Display
the Reference Faces dialog (accessible from the tag's popupmenu) and remove the incorrect or
poorly performing reference faces from the set of reference faces for that tag.

Learn more about
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l Deleting tags
l Adding new face tags

Missing Faces
Historian may occasionally miss a face. There are several reasons for this, including 

l The face is tilted too far one direction or another.
l Something is obscuring the face, such as sunglasses or a hat.
l The face may be too small relative to the size of the photo, such as in a photo of a large
group.

l The face is not looking directly into the camera.

In these cases, you'll need tomanually add the missing face.

l AddMissing Faces During Editing
l AddMissing Faces Using Preview

Turn on Facial Recognition

Before you can use the facial recognition features of Historian , you must enable it in the media
vault Properties dialog box.

Note: Facial recognition must be enabled on a vault-by-vault basis. Disabling facial recognition
may speed up performance in other areas of the software.

To enable facial recognition, perform the following steps:

1. From the File tab, select Properties.

2. Themedia vault Properties dialog box displays. Click General to display the general vault set-
tings.

3. In the Facial recognition section, click Enabled.

4. ClickOK to save your changes.
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Automatically Scan for Faces

Once you enable facial recognition in your Media Vault, you can automatically scan your library for
faces and assign face tags.

Note: When you automatically scan your library for faces, only the view selected at the time (such
as a view chosen by date or category). To scan all of your files, click All in the View section of the
Home ribbon.

To automatically scanned all displayed images in your library, perform the following steps:

1. Click Recognize faces from the Face section of the Home ribbon.

2. A dialog box displays. ClickOK to continue.

Tip: ClickDon't show this again to run future scans without this dialog box.

3. The Recognize faces dialog box displays.

Note: If you already have face tags assigned to some images, Historian will try to assign those tags
to new images. For instance, if you have "Shelley" assigned to images, Historian will try to find
more images to be tagged "Shelley." You will have to tell the software whether this is correct or
incorrect. For more information, refer to Step 6.
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4. Click the arrow next to the face. A pop-upmenu appears.

View the pop-upmenu options.

Option Description

Add a new face tag

Add a brand-new tag that is asso-
ciated with this face.

The Create a New Tag dialog box
displays. Add a Name for the face
and choose a category for the tag.
Face tags can be stored in any cat-
egory.

For more information, refer to Add-
ing a New Face Tag.

Select a different face tag.

Add this face to an existing face
tag.

The Select an existing tag pop-up
appears. Select the appropriate
face. You may need to scroll
through the list if you have a large
number of face tags.

View the pop-up.
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Option Description

Ignore this face. Don't assign a face tag to this face.

5. Do this for each face displayed.

6. Once you have tagged a certain number of faces, Historian will try to identify faces based on
your tags. The Recognize faces dialog box changes. In the new display, click on the faces that do
notmatch the tag.

Note: If you already have face tags assigned to some images, Historian will try to assign those tags
to new images. For instance, if you have "Shelley" assigned to images, Historian will try to find
more images to be tagged "Shelley." You will have to tell the software whether this is correct or
incorrect.

In this example, we have excluded the image that is not Shelley.
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7. In the third step of the Recognize Faces dialog, you're asked to confirm or change the tags His-
torian has associated with the image.
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If the tag is ... Then ...

Correct
Click to confirm the association.

Incorrect

Click the arrow to view the pop-upmenu.

Choose:

l Any of the suggested face tags.
l Add a new face tag if the face is not yet in your library.
l Select a different face tag if the face has already been
tagged in this library.

l Ignore this face to not assign a tag.
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Note: You will process through these steps as often as needed until all faces in your current view
have been identified or ignored. If you are processing a large view or your entire library, this may
take a long time.

8. Once you have done this for all of the faces detected in the current view, click Save.

9. Historian displays a Processing Complete dialog box. ClickOK.

Tip: Historian may occasionally miss a face. There are several reasons for this, including

l The face is tilted too far one direction or another.
l Something is obscuring the face, such as sunglasses or a hat.
l The face may be too small relative to the size of the photo, such as in a photo of a
large group.

l The face is not looking directly into the camera.

In these cases, you'll need tomanually add the missing face.

Scan for Faces on Import

Historian can automatically scan for recognized faces when you import new images into the soft-
ware.

When you import new images using any method, perform the following steps: 

1. Click Import Options from the importing dialog.

2. The Import Options dialog box displays. Click Run Facial recognition on imported images.

Note: This option is only available if facial recognition is available in the vault. To learn more, refer
to Turn on Facial Recognition.

3. ClickOK to save your changes and continue importing your images. Facial recognition will run
as the items are imported into your vault.

Tip: Historian may occasionally miss a face. There are several reasons for this, including

l The face is tilted too far one direction or another.
l Something is obscuring the face, such as sunglasses or a hat.
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l The face may be too small relative to the size of the photo, such as in a photo of a
large group.

l The face is not looking directly into the camera.

In these cases, you'll need tomanually add the missing face.

Add Missing Faces Using Preview

Occasionally, Historian will miss a face and you'll need to add faces manually. You can do this in sev-
eral ways.

To add a face tag from image preview, perform the following steps:

Note: This option is only available if facial recognition is available in the vault. To learn more, refer
to Turn on Facial Recognition.

1. Select Preview > Show image preview with faces.

2. The Preview screen appears and the cursor changes to a crosshair.

3. Click between the eyes of the person you want to identify. Starting on the nose, draw a box to
surround the face.

4. The Add amanual face tag dialog box displays.
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l Click and drag the thumbnail to better position it.
l Select an existing face tag or add a new one. To learn more about adding new tags, refer to
Adding a New Face Tag.

5. Once you have assigned a tag, the image displays with faces identified.

Add Missing Faces During Editing

Occasionally, Historian will miss a face and you'll need to add faces manually. You can do this in sev-
eral ways.

To add a face tag during editing, perform the following steps:

Note: This option is only available if facial recognition is available in the vault. To learn more, refer
to Turn on Facial Recognition.

1. Double-click an image in the media library to open the editing features.

2. In the Image ribbon, click Face.

3. The Image Editor displays directions for manually adding a face.
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4. In the image display, click between the eyes of the person you want to identify. The cursor
changes to a crosshair. Starting on the nose, draw a box to surround the face.

5. The Add amanual face tag dialog box displays.

l Click and drag the thumbnail to better position it.
l Select an existing face tag or add a new one. To learn more about adding new tags, refer to
Adding a New Face Tag.

6. Once you have assigned a tag, click Close in the image editor. The image is saved.

Add Missing Faces in Item Properties

Occasionally, Historian will miss a face and you'll need to add faces manually. You can do this in sev-
eral ways.

To add a face tag from the Item Properties panel, perform the following steps:

Note: This option is only available if facial recognition is available in the vault. To learn more, refer
to Turn on Facial Recognition.

1. Select an image in the media library.

2. In the Item Properties panel, choose the Faces arrow.
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3. Click the blue arrow to allow Historian to search existing face tags.

Note: If there are already face tags associated with this image, they will be deleted and reset with
the tags you choose

4. If Historian cannot find a face, the image will not be updated. If this happens, assign a face tag
using image preview or during editing.

5. If Historian finds a face, it will appear in the Faces section of Item Properties.

Note: If a faces tag is incorrect, you can remove it. For more information, refer to Working with
Tags.
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Editing Images
Reviewing Changes

When you are making changes, you can preview the changes and compare those with the original.
Most dialog boxes have a footer that contains Preview,Accept, andCancel.

1. Make modifications to your image using the options in the editing dialog box.

2. Click Review to view before and after versions of your image.

3. If you want to retain the changes, click Accept. If you want to discard the changes, click Can-
cel.

Undo a Change

When you modify an image within Historian , you have the option of undoing the change even
after applying the change.

There are three ways to undo a change within the Editing view:

l Click Undo in the toolbar. This will return the image to the last state within the filter.

OR

l Right-click on the image and select click Undo.

OR

l  You may also use the keyboard command of CTRL-Z to undo a change.

Using the Reset Option

The Reset Option is available in Editing View within any option that you can set yourself.

This example shows the Color balance options. You can see the Reset button in the lower right
corner.
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Click Reset to restore all sliders or buttons to their original, default positions.

Saving Your Changes

When you modify an image within Historian , you have the option of creating a revision or to
create a totally new file. A revision is a second version of your image. A new file becomes an original
unto itself.

Note: After making changes, you will be prompted to save the current image before printing,
exporting, sharing or saving to another file.

l Using Save
l Using Save As

Using Save
To save your image, perform the following steps:

On the toolbar, click the Save button to save your changes to the image.

Using Save As
1. Right-click on the image and select Save As. A pop-upmenu displays.

2. Select Save As from the menu if you wish to do one of the following:

l Create a new revision. You must have revision management enabled to access this option.
For more information, refer to Setting User Options.
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l Create a new original image. This image will be a standalone image andwill not be asso-
ciated with the original that you edited.

l Create a new image file in Windows.

Create a new revision.

For more information, refer to Using Revisions.

Create a new original image.

l ClickNew item from the pop-upmenu.
l The Create new original image dialog displays. Enter a new name and clickOK.

l Your new image is created.

Create a new image file in Windows.

Note: This option saves a file outside of Historian and your media vault.

l Click New image file from the pop-up.
l The Save File As dialog displays. Browse to the location on your computer where you would
like to save the file.
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l Click Save. The file is saved to your local computer.

Using Revisions

When you modify an image within Historian , you have the option of creating a revision. A revision
is a second version of your image.When you create a revision, your original image is preserved.

Note: If you do not have access to revision management, select Enable revision management
in the General section of the User Settings dialog box. Revision management is enabled when the
Revisions button displays in the Editors panel. For more information, refer to Setting User Options.

l Saving a New Revision
l Accessing Your Revisions

Saving a New Revision
To save your image as a revision, perform the following steps:

Notes: 

l The Save button displays the New Revision option only if the current revision is protected.
Originals are automatically protected.

l If Automatically protect new revisions is selected in the Options dialog box, other revisions
will be protected as well. If the option is not checked, may not see the New Revision option
on Save.

1. Click Save to save your changes.

Note: If you do not wish to save your changes, click Close, followed by No in the con-
firmation box.

2. A dialog box appears. ClickNew Revision to save your changed image as a new version.
This option keeps your original file intact.

Note: Only select Overwrite if you are positive that you will not need to access your orig-
inal file. Overwrite will replace your original file with the changed image.
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Note:When you are saving a new revision in any format other than JPG or TIF, the soft-
ware will prompt you for a format. 

Learn more.

When you save a new revision in a format other than JPG or TIF, Historian displays the New
Revision dialog box:

You can choose a new file format from the drop down list. Choose the same format if you
wish to retain the original format.

3. Right-click your image and select Revisionsto view your revisions.

4. The Revisions for File Namewindow appears. The last revision displays as active. An active
revision is highlighted in blue and shown on the main window.

Notes:

l A protected image cannot be modified without confirmation, but subsequent
revisions may be modified.

l The active revision displays in your Media Library.
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5. Select any version from the Revisions column. The selected revision is displayed.
6. Click any button on the right side to learn more about the image:

l Open:Open launches the image in the editingmode.
l Information: Information provides detailed image information, such as camera
make andmodel and exposure time. The original image will contain more infor-
mation than a revision.

l Duplicate: Duplicate creates another revision within the Revisions for File Name win-
dow.

l Set Active: Set Active is only available when working with non-active revisions. This
option sets the active, displayed revision. The active revision will display in the Media
Library.

l Unprotect/Protect: This option shows as either Protect or Unprotect, depending
on whether the revision is already protected. A protected image cannot be modified
without confirmation. Any modifications made to a protected image will be saved to a
new revision.

l Delete: Delete will delete the selected revision. A confirmation box will ask you to
confirm the deletion.

7. Click Close to close theRevisions for File Namewindow and return to the Media Library.

Accessing Your Revisions
You can access your revisions from the Media Library as well as the Editors Panel. To access your
images from the Media Library, perform the following steps:

1. Select an image from the Media Library.
2. Right-click on the selected image.
3. Select Revisions from the resultingmenu.

Note: This option is only available for images that have revisions. 
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Using the Color Picker

There are several locations in the software where you can access the Color Picker. The Color Picker
lets you create and save a customized color.

1. Select a starting color. You may select a color from the Named Colors chart or by choosing a
sample color. A sample color is chosen from outside the Color Picker dialog box.

2. Click the eyedropper tool to select a sample color.

3. Your cursor changes to an eyedropper.
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4. Move the mouse around the software. As you pass over different colors, they are displayed
in the sample box.

Note: You cannot leave the software when choosing a sample color.

5. When you identify a color you like, click the area with the eyedropper.
6. The color is displayed in the sample box.
7. If needed, click the RGB and/orHSB tabs and use the sliders to adjust the color. Exper-

iment with each slider. The new color displays in the sample box.
8. The new color displays in the Recent Colors section of the List tab.

Using Right-Click When Editing

The options available on the right-click menu change depending on where you are in the software.
Right-click an image while in Editing view to see the following options:

Option Description
Undo the last
change Remove the last edit from the image.

Copy Copies the image and allows you to import the copy into the Media Library as a
new image or in any other Windows application that supports copy and paste. .

Add to work area Adds the image to the Work Area. For more information, refer to Using the WorkArea
Save Save the file by overwriting the current file. Refer to Saving Your Changes
Save as Save the file as a new image, a new file in Windows, or a new revision.
Delete from
media vault Remove the image permanently from your media vault.

Revisions Access any revisions. This option is only available if you have revision man-
agement enabled. For more information, refer to Using Revisions

Add to an album Add the image directly to a specific album.

Tagwith ... Add a tag or tags to the image. For more information, refer to Adding and
RemovingMedia within Tags

Remove a tag
from this item

Remove a tag from the image. For more information, refer to Adding and Remov-
ingMedia within Tags

Print Print to a local printer, a web-based provider or the Panstoria Digital Center. For
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Option Description
more information, refer to Printing to a Local Printer
This option also lets you mark the image as printed, not printed, or need to print
for the print status view. For more information, refer to DisplayingMedia Using
Find Options

Share
Share to multiple options, including social media, Windows Movie Maker. You
can also export to a file, CD/DVD, or a slide show. For more information, refer to
Sharing Your Memories

Item Properties Display the Item Properties dialog box.

Understanding the Histogram Panel

Histograms reflect your color usage as you edit and enhance your images. A color histogram is
defined as a representation of an image derived from counting the color of each pixel. Reveal the
histogram by clicking the arrow underneath your selected dialog box.

The color blocks on the upper left of the histogram affect the light level of red, green, and blue. The
bottom block affects all colors.

In this example, we are looking at an older black andwhite photograph.
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Original
Black and White Photo Histogram for this Photo

In the next example, we have improved the coloring of the photo using the Quick Fix section of the
Image ribbon. The adjoining histogram has changed, showing choppier lines andmore red tones.

Corrected
Black and White Photo Histogram for this Photo
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In this example, we have changed the coloring of the photo to sepia using the Quick Color Fix tool.
The adjoining histogram has changed again, this time reflectingmore colors.

Sepia Photo Histogram for this Photo

Modifying Your Images with an External Editor

While Historian provides many ways to edit and enhance your images, you may prefer an external
editing application.

Tip: Editing a RAW image in an external editor will preserve the RAW format.

To edit your images in an external application from Historian, perform the following steps:

1. Select your image in the Media Library. From the drop-down menu, select Open Image
With ...

2. Any image editors installed on your machine display. Choose your preferred application.
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3. The image editor opens. Make your changes and save your file. .
4. When you return to Historian , the image is markedwith an Editing tag.

The drop-down menu also includes an new submenu, External Editing.

View External Editing submenu options.

Options Explanations

Complete This copies the copy of the image updatedwith the External Editor back intothe Vault. The Editingmarker is removed from the image.
Cancel This clears the Editingmarker and removes any changesmade externally.
Reopen
Image
With

This allows you to reopen the image in the same External Editor.

5. From the External Editing submenu, choose Complete. This saves your changed image
back into the vault and removes the Editingmarker.

122 Copyright © 2005-2013 Panstoria, Inc.



Editing Images

Image Ribbon

Image Options

Using the Image Section

The Image section of the Image ribbon has several options.

Option Description

Assistant

The Image Assistant walks you through basic editing functions for an image. Refer to
Using the Image Assistant: Introduction

Face The Face option lets you manually add a face tag to an image. Refer to AddMissing
Faces During Editing

Reference
Image

The reference image serves different purposes:

l You can bring in a reference image to use as comparison. Reference images
may be grabbed from your media library, copied from the current image, pulled
from anywhere on your computer, or downloaded from Facebook, Flickr or
Picasa.

l Reference images can also be used as alternate cloning sources. Refer to Using
Cloning Tools and Using an Alternate Clone Source for more information.

Using the Image Assistant

Using the Image Assistant: Introduction

Historian provides many ways to enhance your images. You can use the Image Assistant to walk
you through each step of the process or you may pick and choose which edits you want to make.

The Image Assistant is a wizard that walks you through common editing tools. The Image Assis-
tant is broken into the following steps:

l Step 1: Rotate
l Step 2: Free Rotate
l Step 3: Crop
l Step 4: Quick Color Fix
l Step 5: Lighting Adjustment
l Step 6: Red-Eye Removal
l Step 7: Red-Eye Brush

To use the image assistant, complete the following steps:

1. Access the Image ribbon by doing one of the following:
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l Double-click your image.

OR

l Right-click on your image and select Open.

2. To reach the Image Assistant, select Assistant from the Image ribbon.

Click here to continue to the next portion of the Image Assistant.

Using the Image Assistant: Step 1

Note: You are not required to apply every step of the wizard and you may click Undo at any time to
reverse your latest change.

The Assistant takes you to the Step 1: Fixed Rotate. Complete the following steps to rotate your
image. If your image does not need rotation or requires a custom rotation, click Next.

1. There are several rotation options available. Choose the option you wish to use:
l Clockwise: Click this option to rotate your image 90 degrees to the right.
l Counterclockwise: Click this option to rotate your image 90 degrees to the left.
l Rotate: Click this option to rotate your image halfway around (180 degrees).
l Flip Horizontal: Click this option to flip your image horizontally, providing amirror
image.

l Flip Vertical: Click this option to flip your image vertically. This will fix an upside-
down print.

2. Click the option that fits your needs. The image rotates.
3. ClickNext to move on to the next step of the Image Assistant.

Click here to move on to the next step in the help.
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Using the Image Assistant: Step 2

Note: You are not required to apply every step of the wizard and you may click Undo at any time to
reverse your latest change.

Free Rotation allows you to set a custom angle for your image.

You can adjust the angle in two ways:

1. Adjust the slider.

OR

Drag the image manually.

2. ClickNext to move on to the next step of the Image Assistant.

Click here to move on to the next step in the help.

Using the Image Assistant: Step 3

Note: You are not required to apply every step of the wizard and you may click Undo at any time to
reverse your latest change.

The Image Assistant takes you to the Step 3: Cropmenu. Complete the following steps to crop
your image. If your image does not need cropping, clickNext.
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You can change the size of your images by cropping. Cropping automatically adjusts your image
size to standard print sizes.

Note: Cropping removes elements of your image.

You can also manually crop your image, selecting which parts of your image to remove. To crop
your image, perform the following steps:

1. A Custom crop is based on your preference and does not necessarily conform to a preset
size.

2. Move the dotted square to the appropriate location over your image.While Custom is
selected, you may resize the square by pulling diagonally on the corners.

3. To size your image to a specific size, such as 4x6 or 8.5 x 11, select the size from the radio
buttons in the Cropmenu.

4. The dotted square will resize to your specifications. Drag the square over the appropriate
area of the image.

5. When the dotted square is in your preferred location, click Apply this crop. The image
crops to the desired size.

6. ClickNext to move on to the next step of the Image Assistant.

Click here to move on to the next step in the help.

Using the Image Assistant: Step 4

Note: You are not required to apply every step of the wizard and you may click Undo at any time to
reverse your latest change.

The Assistant takes you to the Step 4: Quick Color Fix. If your image does not need color adjust-
ment, clickNext.

There are many reasons to adjust color. You may want to add color effects, such as warmth or an
old-fashioned look. In other cases, you may want to easily add and remove color or lighting. His-
torian will automatically adjust color for you. To automatically adjust the color of your photo, per-
form the following steps:
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1. Choose from the following options:
l Auto color: This balances the overall colors in your image. (This option was applied
to the example shown.)

l Auto contrast: This balances the lightness and darkness of your image.
l Convert to black and white: This removes the color from the image.
l Convert to sepia tone: This replaces the color in your image with grades of sepia
for an aged appearance.

2. Select the option that fits your needs. The option is applied to the image.

3. ClickNext to move on to the next step of the Image Assistant.

Click here to move on to the next step in the help.

Using the Image Assistant: Step 5

Note: You are not required to apply every step of the wizard and you may click Undo at any time to
reverse your latest change.

1. The Assistant takes you to the Step 5: Light Adjustments menu. If your image does not need
lighting adjustment, clickNext. 

2. Sometimes an image appears too dark or too bright. You can adjust the amount of light and
shadow in your image. To adjust your light levels, experiment with the sliders to adjust the
amount of light in your image.

l Contrast: The difference in brightness between light and dark areas of an image. Contrast
determines the number of shades in the image.

l Brightness: The relative lightness or darkness of an image, which determines the inten-
sity of colors. 
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l Highlights: The brightest elements in an image 
l Midtones: Areas of medium brightness, neither a very dark shadow nor a very bright high-
light.

l Shadows: The darkest elements in an image, and the degree of detail that is discernible in
those the dark portions.

3. Click theNext button tomove on to the next step of the Image Assistant.

Click here to move on to the next step in the help.

Using the Image Assistant: Step 6

Note: You are not required to apply every step of the wizard and you may click Undo at any time to
reverse your latest change.

The Assistant takes you to the Step 6: Red-Eye Removal. Complete the following steps to remove
any red eye in your image. If your image does not need red-eye removal, clickNext.

1. Zoom in on your photo by adjusting the Percentage Indicator at the bottom of the image.

2. Click on the image or close to the red eye.
3. Your mouse pointer will show an eyedropper and a crosshair. Click the eyedropper over the

red eye you wish to remove.
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4. ClickNext to move on to the next step of the Image Assistant.

Click here to move on to the next step in the help.

Using the Image Assistant: Step 7

Note: You are not required to apply every step of the wizard and you may click Undo at any time to
reverse your latest change.

The Assistant takes you to Step 7: Red-Eye Brush. If your image does not need red-eye removal,
click Finish.

1. Zoom in on your photo by adjusting the Percentage Indicator at the bottom of the image.

2. Adjust the brush size on the slider. A higher number denotes a larger brush size.
3. Your mouse pointer will show a circle. Move your mouse over the red eye and click repeat-

edly until the red eye has been removed.
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4. Click Finish button to close the Image Assistant and return to the main Images ribbon.
5. In the Images ribbon, click Save to save your changes.

Crop and Rotate

Cropping Your Images

You can change the size of your images by cropping. Cropping automatically adjusts your image
size to standard print sizes. However, cropping does remove elements of your image. You can also
manually crop your image, selecting which parts of your image to remove.

 To crop your images, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

1. Click Crop in the Image ribbon. The Crop dialog appears. Perform the following steps:

View dialog box.
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Note: You may set the default crop square in the Image Editing portion of the User Options
dialog box. For more information, refer to Setting User Options.

2. Your first crop selections are Custom andSquare. A Custom crop is based on your pref-
erence and does not necessarily conform to a preset size. A Square crop consistently main-
tains a proportional shape.

3. Move the dotted square to the appropriate location over your image.While Custom is
selected, you may resize the square by pulling diagonally on the corners.

4. To size your image to a specific size, such as 4x6 or 8.5 x 11, select the size from the radio
buttons in the Cropmenu.

5. The dotted square will resize to your specifications. Drag the square over the appropriate
area of the image.
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6. When the dotted square is in your preferred location, click Crop. The image will crop to the
desired size.

7. Click Accept to maintain your changes andCancelto remove your changes.

Free Rotating Your Images

Sometimes your imagesmay be sideways or crooked. You can easily correct this using the Free
Rotate tool.

To rotate your images, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

1. Click Free Rotate in the Image ribbon. The Rotate dialog appears. 

2. You can adjust the angle in two ways:

Adjust the slider.

OR
Drag the image manually by dragging the corner. The cursor will change into arrows.
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3. Click Accept to confirm the change. The image adjusts per your specifications.

Tip: To finish your straightened image, apply the Crop tool. Refer to Cropping Your Images to
learn more.

View finished image.

4. Click Accept to maintain your changes andCancel to remove your changes.
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Rotating Your Images

Sometimes your imagesmay be sideways or upside down. You can easily correct this using the
Fixed Rotation buttons.

To rotate your images, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

1. Choose any of the individual rotate buttons to adjust your image. There are several rotation
options available. Choose the option you wish to use:

l Clockwise: Click this option to rotate your image 90 degrees to the right.
l Counterclockwise: Click this option to rotate your image 90 degrees to the left.
l Rotate: Click this option to rotate your image halfway around (180 degrees).
l Flip Horizontal: Click this option to flip your image horizontally, providing amirror
image.

l Flip Vertical: Click this option to flip your image vertically. This will fix an upside-
down print.

Before Rotation After Rotation
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Tip: You can also perform a custom rotation. For more information, refer to Custom Rotating Your
Images.

2. Click Accept to maintain your changes andCancel to remove your changes.

Quick Fix

Applying Auto Fix

The Quick fix section provides tools to quickly adjust your photos.

Auto fix balances the colors and light within your image.

Note: You cannot use Undo to revert changes created with Auto Fix. If you want to undo Auto Fix
changes, you must revert to a previous revision.
(For more information on revisions, refer to Using Revisions.)

1. Click Auto fix in the Quick Fix section. Several versions of your image are displayed.

2. Choose from the following options:

l Auto color: This balances the overall colors in your image. (This option
was applied to the example shown.)

l Auto contrast: This balances the lightness and darkness of your
image.

l Convert to black and white: This removes the color from the
image.
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l Convert to sepia tone: This replaces the color in your image with
grades of sepia for an aged appearance.

3. Select the option you prefer. Historian applies the correction.

4. Click Accept to maintain your changes andCancel to remove your changes.

Adjusting Light

Sometimes an image appears too dark or too bright. You can adjust the amount of light and
shadow in your image.

 To adjust your images, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

1. Click Light in the Image ribbon. The Light dialog appears.

2. Experiment with the sliders to adjust the amount of light in your image.
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l Contrast: The difference in brightness between light and dark areas of an image. Contrast
determines the number of shades in the image. 

l Brightness: The relative lightness or darkness of an image, which determines the inten-
sity of colors. 

l Highlights: The brightest elements in an image
l Midtones: Areas of medium brightness, neither a very dark shadow nor a very bright high-
light.

l Shadows: The darkest elements in an image, and the degree of detail that is discernible in
those the dark portions.

Tip: ClickMore Options to view all five light sliders.

Before Adjustment After Adjustment

3. Click Accept to maintain your changes andCancel to remove your changes.

Convert to Black and White

There are many reasons to adjust color. You may want to add color effects, such as an old-fash-
ioned look. In other cases, you may want to easily add and remove color.

To adjust your colors automatically, perform one of the following:

l Double-click on any image.
l Right-click on an image and select Open Image.

Sometimes a black-and-white image can be more dramatic than the original color image.
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1. Click the Black & White button. The Black andWhite dialog appears.

2. Select a technique from the previews. For more detailed editing, click More Options.

Learn more about the additional options.

The More Options dialog box provides in-depth options and a wide selection of filters, hue adjust-
ments, effects, and RGB adjustments.

Select your options and clickOK.
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3. Once you have applied your technique, click Accept to maintain your changes andCancel to
remove your changes.

Before Black and White After Black and White

Converting Sepia

There are many reasons to adjust color. You may want to add color effects, such as an old-fash-
ioned look. In other cases, you may want to easily add and remove color.

To adjust your colors automatically, perform one of the following:

l Double-click on any image.
l Right-click on an image and select Open Image.

Occasionally you may want to convert an image to sepia tones for a more old-fashioned look.

1. Click the Sepia button.

2. The preview is displayed and the image is converted.

3. Click Accept to maintain your changes andCancel to remove your changes.

Before Sepia After Sepia
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Red-eye

Reducing Red Eye

To adjust your images, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

1. Zoom in on your image by adjusting the Percentage Indicator at the bottom of the image.

2. From the Images ribbon, choose Quick Fix from the Red-eye section. The Red-Eye dialog box
displays.

3. Your mouse pointer will show an eyedropper and a crosshair. Click the eyedropper over the red
eye you wish to remove.

4. The red eye will be replaced by dark gray.

5. Click Accept to maintain your changes andCancel to remove your changes.
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Using the Red Eye Brush

The red-eye removal brush allows you to paint away the red in the eyes.

To adjust your images, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

1. Zoom in on your image by adjusting the Percentage Indicator at the bottom of the image.

2. From the Images ribbon, choose Red Eye Brush from the Red-eye section. The Red-Eye Brush
dialog box displays.

3. Adjust your brush size on your slider. A high number gives you a larger brush.

4. Your mouse pointer will show a small paintbrush. Click the brush over the red eye you wish to
remove.

5. The red eye will be replaced by dark gray.

6. Click Accept to maintain your changes andCancel to remove your changes.
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Adjust Ribbon

Selecting

What is a Selection?

A selection is the part of an image selected for any type of change, such as color modification or
blurring. The selection consists of all the pixels containedwithin the selection boundary.

The selection boundary may be shown in different ways:

Dotted Line: The dotted line may be moving or in place.

Solid fill: The selection may be shown by a solid fill or color wash.

Choosing Selection Tools

The Selection dialog displays several different selection tools. Common Selection Tools
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Each wand dialog box also includes a Selection dialog at the bottom. To learn more about these
common selection options, refer to Common Selection Tools.

TheWand Selection tool allows you to select an area within a similar color range. Learn how to
use the Wand Selection tool.

1. Click the Wand tool. The Wand Selection dialog box displays. 

2. Choose a region selection.

l Single: Select a single region.
l Add: Expands the current selection.
l Remove: Removes regions from the selected area.

3. Choose the selection scope: 

l Brush:When combinedwith the Add to selection option, the brush is a very goodway to
select a complex object like a person, allowing you to “paint” the selection region.

l Adjacent: Clicking an area finds all pixels within the threshold that are connected to the
wand click point or a selected pixel.

l All: Selects all qualifying pixels in the image. This option is useful for selecting everything of
a particular color.

3. Adjust the Threshold and Brush Size to desired levels. A higher number means that the selec-
tion tool will be more "picky" about the pixels it chooses.

4. Click the color your want to select. In this image we have selected the pink in the rose.
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5. Adjust the selection using the various options in the dialog box.

6. Your selected area will remain selected until you save the image or clickDeselect.

The Lasso tool draws freehand selection borders. This tool lets you make very precise selections.
Learn how to use the Lasso Selection Tool.

1. Click the Lasso button on the Selection ribbon. The Lasso Selection dialog displays. 

2. Choose a region selection.

l Single: Select a single region.
l Adjacent: Expands the current selection.
l Remove: Removes regions from the selected area.

3. Click the spots on the image that you want to include in your selection.

4. Use the region selection options to modify your selection.

5. Your selected area will remain selected until you save the image or clickDeselect.
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The Shape tool lets you frame an area in a predefined shape. Learn how to use the Shape Selec-
tion tool.

1. Click the Shape tool. The Shape dialog box displays.

2. Click Change Shape to choose your shape and apply the selection to the image.

3. Your selected area will remain selected until you save the image or clickDeselect.
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Common Selection Options

Each selection tool includes common selection options. These options only affect the image during
editing, and do not affect the finished image.

The Moving andOutline options denote whether or not the dotted selection line appears to be mov-
ing.

You can choose whether to highlight inside or outside of an image. The previous examples have
shown the original (inside) selection. In the following example, we show the image with the area
outside of the selection highlighted. 

You can choose to use a color wash. This does not permanently affect the image - it only highlights
your selection for editing purposes.
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Deselecting an Area

The Select section of the Selection ribbon offers several different options, including Deselect.

Deselect turns off the selection outline.

To deselect an area, clickDeselect on the Selection ribbon or click CTRL+D on your keyboard.

Blending

The Blending dialog box displays only when you have elements of an image selected and are apply-
ing a change to the selected portion.

Blending lets you control the edges of the change you are making to the selected area and how it
blends back into the non-selected portion. You can also invert the area by choosing inside or out-
side.

View an example.

In this example, we have applied the blur option to the background (which was selected) and have
adjusted the sliders to blend the blur into the rest of the image.
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When you have finished blending, click Accept to maintain your changes andCancel to remove
your changes.

Color and Light

Adjusting Light

Sometimes an image appears too dark or too bright. You can adjust the amount of light and
shadow in your image. 

 To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

1. Click Light in the Adjust ribbon. The Light dialog appears.

148 Copyright © 2005-2013 Panstoria, Inc.



Using the Image Assistant: Step 1

2. Experiment with the sliders to adjust the amount of light in your image.

l Highlights: The brightest elements in an image
l Midtones: Areas of medium brightness, neither a very dark shadow nor a very bright high-
light.

l Shadows: The darkest elements in an image, and the degree of detail that is discernible in
those the dark portions.

l Contrast: The difference in brightness between light and dark areas of an image. Contrast
determines the number of shades in the image.

l Brightness: The relative lightness or darkness of an image, which determines the inten-
sity of colors. 

Tip: ClickMore Options to view all five light sliders.

Before Adjustment After Adjustment
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3. Click Accept to maintain your changes andCancel to remove your changes.

Adjusting Color Balance

There are many reasons to adjust color. You may want to add color effects, such as warmth or an
old-fashioned look. In other cases, you may want to easily add and remove color or lighting.

To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

If you have toomuch, or too little, of a particular color in an image, you can adjust the color bal-
ance.

1. Select Color Balance from the Adjust menu.

2. The color balance dialog box displays a set of sliders.

3. Adjust the amount of any color by adjusting the sliders.

Before: After:
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4. Click Accept to maintain your changes andCancel to remove your changes.

Applying Hue and Saturation

There are many reasons to adjust color. You may want to add color effects, such as warmth or an
old-fashioned look. In other cases, you may want to adjust or add skewed color.

You can achieve several of these affects by applying hue and saturation. Hue is the actual color.
Saturation is the purity of the color.

 To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

1. ClickHue and Saturation in the Color and Light section of the Adjust ribbon.

2. The Hue and Saturation dialog appears.
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2. Adjust the sliders on the color scales. The Hue and Saturation sliders allow you to adjust the
color and saturation, creating very bright or faded images and/or modifying the color.

Tip: Modify the colors or sample colors from the screen. For more information, refer to Using the
Color Picker.

3. Click Accept to maintain your changes andCancel to remove your changes.

Adding Color Wash

You can add a wash of color over your entire image, adding a creative touch to your photo.

To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.
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1. Click Color Wash in the Color and Light Editors section of the Adjust Ribbon. The Color Wash
menu appears. 

2. Choose a color by moving the slider or selecting a sample hue using the Color Picker. Adjust the
saturation and intensity.

Before Wash After Wash

3. Click Accept to maintain your changes andCancel to remove your changes.

Matching Color

Sometimes a photo has toomuch of one color or not enough of another. You can match a color to
change the appearance of an image.

To adjust your image, perform one of the following to access the editing ribbons:
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l Double-click on any image.
l Right-click on an image and select Open Image.

From the Adjust ribbon, clickMatch Color in the Color and Light section. TheMatch Colormenu
appears. 

1. You may choose tomatch a color to white, gray, black, or the color of your choice using the Color
Picker.

2. For this example, we choseMatch White.

Before Applying Match Color

3. The cursor changes to an eye dropper. Place the eye dropper over the color you wish to change
(match) to white. In this example, we are changing the gray-tinged snow to white.
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Notice the Location and Shape of the Cursor

4. Click the area where your cursor is located. Historian identifies the color throughout the image
and changes it to your selected color. In this case, the gray-tinged snow has been changed to
white and the picture has been significantly brightened.

After Applying Match Color

5. Click Accept to maintain your changes andCancel to remove your changes.

Adjusting Temperature

There are many reasons to adjust color. You may want to add color effects, such as warmth or an
old-fashioned look. In other cases, you may want to easily add and remove color or lighting.

To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.
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Temperature allows you to adjust the degree of heat that an object would have to absorb before it
glows in a certain color. Each color is associated with a color temperature, as are various kinds of
light.

1. Select Temperature from the Adjust menu.

2. The dialog box displays a slider.

3. Adjust the amount of any color by adjusting the slider.

Original

Warmer
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Cooler

4. Click Accept to maintain your changes andCancel to remove your changes.

Adjusting Color Curves

The amount of color in an image is a fine balance. A change you make to one color directly affects
the other colors in the photo. For instance, if you increase the amount of green in an image, you
automatically decrease the amount of magenta. You can intensify overall color in an image using
the Color Curves tool.

Using curves achieves an overall shift in shadows, midtones, and highlights. You might do this to
adjust the colors in your photo or to add amore creative touch to your photos.

To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.
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1. Click Curves in the Color and Light Editors section of the Adjust Ribbon. The Color Curvesmenu
appears. 

2. Drag the line in the histogram to adjust the color in the image. The color blocks on the left affect
the balance of red, green, and blue. The bottom block affects all colors. If you drag towards the
upper left corner, you will intensify your chosen color. If you drag towards the lower right corner,
you will remove the chosen color.

Before Adjustment After Adjustment

4. Click Accept to maintain your changes andCancel to remove your changes.
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Adjusting Levels

Sometimes an image appears too dark or too bright. If you want precise control over the adjust-
ment, use the Levels option.

 To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

1. From the Adjust ribbon, select Levels in the Color and Light section. The Light Levels graph dis-
plays.

2. In the graph, move the slider back and forth to manually adjust the levels. The color blocks on
the left affect the light level of red, green, and blue. The bottom block affects all colors.

Before Adjustment After Adjustment

4. Click Accept to maintain your changes andCancel to remove your changes.
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Convert

Convert to Black and White

There are many reasons to adjust color. You may want to add color effects, such as an old-fash-
ioned look. In other cases, you may want to easily add and remove color.

To adjust your colors automatically, perform one of the following:

l Double-click on any image.
l Right-click on an image and select Open Image.

Tip:While the QuickFix option in the Image ribbon allows you to convert an image to black and
white, the Adjust ribbon option allows you to convert just a selection to black andwhite. Use the
Common Selection Tools to choose the part of your image to convert.

Sometimes a black-and-white image can be more dramatic than the original color image.

1. Click the Black & White button. The Black andWhite dialog appears.

2. Select a technique from the previews. For more detailed editing, click More Options.

Learn more about the additional options.
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The More Options dialog box provides in-depth options and a wide selection of filters, hue adjust-
ments, effects, and RGB adjustments.

Select your options and clickOK.

3. Once you have applied your technique, click Accept to maintain your changes andCancel to
remove your changes.

Before Black and White After Black and White
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Converting Sepia

There are many reasons to adjust color. You may want to add color effects, such as an old-fash-
ioned look. In other cases, you may want to easily add and remove color.

To adjust your colors automatically, perform one of the following:

l Double-click on any image.
l Right-click on an image and select Open Image.

Tip:While the QuickFix option in the Image ribbon allows you to convert an image to sepia, the
Adjust ribbon option allows you to convert just a selection to sepia. Use the Common Selection
Tools to choose the part of your image to convert.

Occasionally you may want to convert an image to sepia tones for a more old-fashioned look.

1. Click the Sepia button.

2. The preview is displayed and the image is converted.

3. Click Accept to maintain your changes andCancel to remove your changes.

Before Sepia After Sepia

Focus

Choosing Soften Options

Applying focus is more than just taking the blur out of a blurry image. You can soften the edges of
portraits and other scenes, making an image more romantic.
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 To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

Choose Soften from the Adjust ribbon. The Soften dialog box displays.

Tip: To view the Blur and Opacity sliders, clickMore options.

Soften Filter Example

Soften applies a soft focus to the entire photo.
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Soften Filter Example

Apply soft focus effect applies an subtle blur to
the entire photo.

Blur adds an all over blur to your image.

Tip: This is great for applying blur to a selected
part of your image. In the example shown, blur
is applied to the background elements. For
more information, refer to What is a Selection?

When you have applied a soften option, click Accept to maintain your changes andCancel to
remove your changes.

Choosing Sharpening Options

Applying focus is more than just taking the blur out of a blurry image. Focus can clear up a slightly
out-of-focus image and bring out the edges within an image. Sharpening is about restoring edges
that have been lost during the photo-taking process. While you may want fuzzy edges in a pho-
tograph, in order to soften the overall effect, in other images, you will want to sharpen the lines of
the image contents.

 To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.
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Choose Sharpen from the Adjust ribbon. The Sharpen dialog box displays. 

Tip: To view the Custom option and the Range and Threshold sliders, clickMore options.

Sharpen Filter Example

The Sharpen option starts to bring out the edges
in a soft or slightly blurry image. In many cases,
but not all, Sharpen may improve a slightly out-
of-focus image.

Sharpen More brings out the edges in the com-
position of the image. In the example shown,
notice how the edges of the sculpture begin to
slightly pop after the filter is applied.
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Sharpen Filter Example
Custom gives you the opportunity to apply your
own adjustments, using the Range and Thresh-
old sliders.

Note: Custom and the Range and Threshold slid-
ers are available by selectingMore Options.

 When you have applied a soften option, click Accept to maintain your changes andCancel to
remove your changes.

Clean Up: Applying Despeckle

Sometimes an image needs to be cleaned up because it has spots or noise. The Cleanup tool has
two options, Median and Despeckle, that can cleanse your images.  

Sometimes an image appears to have spots or speckles. Generally this noise is introduced during
scanning or image processing. Despeckle applies a filter to the entire image to help decrease and
remove the speckles. The Despeckle filter detects the edges in an image (areas where significant
color changes occur) and blurs all of the selection except those edges. This blurring removes noise
while preserving detail. Despeckle differs for every image and you will have to play with the con-
trols to find the amount of filter you like for each image.

1. Click Cleanup on the Adjust Ribbon. The Cleanup dialog appears.  

2. Select Despeckle.

Tip: View the Range and Threshold sliders by selectingMore Options.

3. Adjust the Range slider. Range controls the amount of smoothing applied by the filter.

4. Adjust the Threshold slider. Threshold controls the amount of color allowed into the smoothing.
A smaller number looks at less color.
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Tip:  Adjusting these values may make the image blurry. Stop at the smallest value that elim-
inates the noise.

Before Adjustment After Adjustment

5.When you have applied a soften option, click Accept to maintain your changes andCancel to
remove your changes.

Clean up: Applying Median

Sometimes an image needs to be cleaned up because it has spots or noise. The Cleanup tool has
two options, Median and Despeckle, that can cleanse your images. 

The Median filter reduces noise by blending the brightness of pixels within an image. Median is use-
ful for eliminating or reducing the appearance of motion or graininess in an image.

1. Click Cleanup on the Adjust Ribbon. The Cleanup dialog appears.  

2. SelectMedian.

Tip: View the Range slider by selectingMore Options.
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3. Adjust the Radius slider to smooth out your image.

Before Adjustment After Adjustment

4.When you have applied a soften option, click Accept to maintain your changes andCancel to
remove your changes.

Other Options

Resizing Your Images

Resizing your images is different from cropping your images. When you resize your image, the pho-
tographic detail remains, but the image shrinks. Images are sized in pixels, which are the millions
of tiny dots that make up the photograph. Resizing your image lowers the number of pixels.

To resize your images, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.
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Select the Adjust ribbon and click Image Size. The Image Size dialog displays.

1. Make sure the checkbox forMaintain Aspect Ratio is selected at the bottom of the box. If this
checkbox is not selected, your image will display a skewed shape.

2. Select your measurement (pixels, inches, or millimeters) from the drop-down list.

3. Enter the new image size for both width and height.

4. Click Accept to maintain your changes andCancel to remove your changes.

Applying Filters

You can apply a number of filters to photos to create interesting effects.
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You can easily apply filters to an element. The Filters button launches the Filters pop-upmenu.

From the Filters pop-upmenu, select the filter you want to apply. Each filter has individual set-
tings, such as pattern, softness, and levels. Experiment with each setting to find the customized
filter you prefer.

Once you have applied a filter you like, click Accept to maintain your changes andCancel to
remove your changes.

View Artistic filters

Option Example

Diffuse Glow
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Option Example

Rough Painting

Oil Painting

Angled Spray

Fractal Map
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View Edges filters.

Option Example

Alpha Gradient

Soften Edge

3D Edge

View Distortion filters.
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Option Example

Vibrations

Rippled Glass

Ocean Waves

Old Glass
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Option Example

Water Drop

Sphereize

Swirl

View Surface filters.
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Option Example

Frosted Glass

Film Grain

Mosaic Tiles (4)

Mosaic Tiles (6)
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View Stylize filters.

Option Example

Emboss

Threshold

Palettize
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Option Example

Invert

Canny Edge

Show Edges

Posterize
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Touchup Ribbon

Using Brushes

The Touchup tab displays a series of brushes that help you make changes to your image. 

Each brush has a series of common options: 

Brush Option Description

Diameter

Diameter is the size of the brush.

View examples.

Large diameter: 

Small diameter:

Opacity

Opacity is the amount of light, or trans-
parency, in the color/effect you are apply-
ing to the image.

View examples.

These lines were drawn with a large dia-
meter brush using the same black color
on the same blue background.
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Brush Option Description

100% opacity:

26% opacity:

Hardness

Hardness is the amount of pressure
applied by the brush.

View examples.

100% hardness:

15% hardness:

Using Cloning Tools
The Touchup tab displays a series of brushes that help you make changes to your image.

To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

Cloning is a great way to add, duplicate, or remove things from your images. Historian lets you
clone within an image and clone from a reference image.

To use cloning, select the Touchup tab and click Clone. The Cloning dialog box displays.
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Cloning Within an Image

1. Adjust the slider for magnification.

2. Adjust the dial for direction.

3. Choose a sampling point. Click Set Sample point and click on the point in the image you want to
duplicateThe mouse will change to a Stamper icon while sampling.

4. Click on the image where you want to duplicate the sampled area. Paint the area, as you would
with a brush. The sampled area will replace the original image.

Before Cloning After Cloning
The fence has changed.
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5. Click Accept to maintain your changes andCancel to remove your changes.

Tip: To clone from a different image, refer to Using an Alternate Clone Source.

Using an Alternate Clone Source
You can also add things to your photos using a reference image. You can select an reference image
from your media library, your computer, or social media sites.

 1. In the Image ribbon, click Reference Image. Select the image you want to clone from. This is
the image that contains an area you wish to duplicate elsewhere.

2. A smaller reference image appears next to your current image. In this example, we have a light-
house as our main image and our reference image is the same lighthouse, but with flags in the
corner.
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3. In the Touchup ribbon, select the Clone brush.

4. Adjust your brush size and pressure. A larger brush covers a larger area. For more information,
refer to Using Cloning Tools.

5. Choose a sampling point on the reference image by clicking on the area and holding down the
SHIFT key. In this example, we are sampling the flags.

6. Click on the primary image where you want to duplicate the sampled area. Paint the area, as
you would with a brush. The sampled area from the alternate image will replace the original image.

Before Cloning After Cloning
The flags have been added
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7. Click Accept in the Clone dialog box.

Applying Paint
The Touchup tab displays a series of brushes that help you make changes to your image.

To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

You can apply a solid color to parts of your image. The Paint tool functions similar to a spray can of
paint.

1. Click Paint from the Touchup tab. The Color dialog box displays.

2. Select a color to apply.

Note: The dialog box allows you to choose colors from the screen using the Color Picker. Learn
more about the Color Picker.
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3. Select your brush size and pressure.

4. Paint the area you wish to change with the brush. The color in that area should be washedwith
your chosen color. In the example shown, we added a blue wash to the girl's outfit.

Before After

5. Click Accept to maintain your changes andCancel to remove your changes.

Using the Smudge Brush
The Touchup tab displays a series of brushes that help you make changes to your image. 

To adjust your image, perform one of the following to access the editing ribbons:
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l Double-click on any image.
l Right-click on an image and select Open Image.

The Smudge Brush is like dragging your finger through wet paint. The color you choose smears in
the direction you push the brush. It can be useful for showingmovement or add artistic flare to
your foreground.

1. Choose Smudge on the Touchup tab. The Smudge dialog box displays.

2. Select your brush settings by moving the sliders.

3. Smudge parts of your image. In the example below, we have smudged the snowboard.

Before After
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4. Click Accept to maintain your changes andCancel to remove your changes.

Using Lighten
The Touchup tab displays a series of brushes that help you make changes to your image. 

To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

The Lighten Brush allows you to selectively brighten areas of your image by painting. Both the
Lighten and Darken brushes are excellent tools for improving image contrast and detail on older
black andwhite image scans. The Lighten feature allows you to selectively brighten areas of your
image by painting. Both the Lighten and Darken brushes are excellent tools for improving image
contrast and detail on older black andwhite image scans.

1. Click Lighten in the Touchup tab. The Lighten dialog appears.

2. Select your brush size and pressure.

Tip: Brush pressure is important in brightening. The harder you press, the more apparent your
lines. Pressing softly will provide a softer, more blended appearance.

3. Move your mouse over the image.
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4.When you have decidedwhere you want to add brightness, click and drag your mouse. You will
be able to paint bright strokes in needed areas. In this example, we have run the Lighten brush
over any snowy areas in the photo.

Before Lighten After Lighten

5. Release the mouse to begin again.

6. Click Accept to maintain your changes andCancel to remove your changes.

Using the Darken Brush
The Touchup tab displays a series of brushes that help you make changes to your image. 

To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

The Darken brush allows you to selectively darken areas of your image by painting. Both the
Lighten and Darken brushes are excellent tools for improving image contrast and detail on older
black andwhite image scans.

1. ClickDarken in the Touchup tab. The Darken dialog box displays.
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2. Select your brush size and pressure.

Tip: Brush pressure is important in darkening. The harder you press, the more apparent your
lines. Pressing softly will provide a softer, more blended appearance.

3. Move your mouse over the image.

4. When you have decidedwhere you want to add darker areas, click and drag your mouse. You
will be able to paint dark strokes in needed areas. In this example, we have applied the Dodge tool
to her hat and coat.

Before Darken After Darken

5. Release the mouse to begin again.

6. Click Accept to maintain your changes andCancel to remove your changes.
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Using Blur
The Touchup tab displays a series of brushes that help you make changes to your image. 

To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

The Blur Brush softens specific portions of an image. This is useful for reducing fine lines, wrinkles,
and imperfections. You may also choose to soften one portion of an image, such as the back-
ground, which will bring sharper focus to the main composition of the image.

Tip: Historian includes two separate Blur elements. Blurwithin the Soften option,located in the
Adjust Ribbon, blurs the entire photo. The Blur Brush, located in the Touchup Ribbon, allows you to
fine tune specific areas of a photo.

1. Click Blur in the Touchup tab. The Blurmenu appears. 

2. Select your brush size and pressure.

Tip: Brush pressure is particularly important with Blur. If you "press" too hard, your photo will
cross the line from softened to blurry.

3. Move your mouse over the image.

4. When you have decidedwhat portion of the image you wish to blur, repeatedly click your
mouse.

Before Blur:

This portion of a close-up shows
wrinkles.

After Blur:

Using the blur brush, we were able
to soften the wrinkles.
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5. Click Accept to maintain your changes andCancel to remove your changes.

Colorizing Your Images
The Touchup tab displays a series of brushes that help you make changes to your image. 

To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

When you colorize an image, you are adding a pale color wash to parts of your image. The Colorize
tool is similar to using a brush stroke. 

1. Click Colorize from the Touchup tab. The Colorize dialog box displays.

2. Select a color to apply.

Note: The dialog box allows you to choose colors from the screen using the Color Picker. Learn
more about the Color Picker.

3. Select your brush size and pressure.
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4. Paint the area you wish to change with the brush. The color in that area should be washedwith
your chosen color. In the example shown, we added a pink wash to the white roses.

Before After

5. Click Accept to maintain your changes andCancel to remove your changes.

Decrease Color
The Touchup tab displays a series of brushes that help you make changes to your image. 

To adjust your image, perform one of the following to access the editing ribbons:

l Double-click on any image.
l Right-click on an image and select Open Image.

Sometimes a photo has toomuch of one color. Using the Decrease Color tool, you can use a brush
to selectively remove that color from the image.

1. In the Touchup tab, chooseDecrease color. The Decrease Color dialog box displays.

2. Select your brush size, opacity and pressure.
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3. Paint the area you wish to change with the brush. The color in that area should be replacedwith
white. In the example shown, we removed the blue tint from the snow but allowed the sky to
remain dark.

Before After

4. Click Accept to maintain your changes andCancel to remove your changes.

Increasing Color
The Touchup tab displays a series of brushes that help you make changes to your image. 

To adjust your image, perform one of the following to access the editing ribbons:
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l Double-click on any image.
l Right-click on an image and select Open Image.

Sometimes a photo is faded in spots, or throughout the entire photo. Using the Increase Color tool,
you can selectively add color to a photo.

1. In the Touchup tab, click Increase color. The Increase color dialog box displays.

2. Select your brush size, opacity, and pressure.

3. Paint the area you wish to change with the brush. The color in that area should brighten. In the
example, we have applied the brush to the colored area of the painting. The faded colors are now
much brighter.

Before After

4. Click Accept to maintain your changes andCancel to remove your changes.
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Creating Albums
Using Bookshelves

Bookshelves are the top level of organization definedwithin the Bookshelves panel. You are
required to place each album you create within a bookshelf.

Note: You must create an album within a bookshelf. You cannot place images directly into a book-
shelf.

When you create a new album within a bookshelf, the album is displayed on the
Album Selection screen to the right of the bookshelves. To view the contents of any album, dou-
ble-click the album name. You may also hold your mouse over the album name and click the drop-
down arrow to view other options.

Adding a Bookshelf
Perform the following steps to create a new bookshelf:

1. Click New Bookshelf from the Create ribbon. The Create a new bookshelf dialog box appears.

2. Enter a name for your new bookshelf.

3. ClickOK. A new bookshelf appears alphabetically within the list.

Edit a Bookshelf
Perform the following steps to edit a bookshelf:

1. Hold your mouse over the bookshelf and click the drop-down arrow. A pop-upmenu appears.

2. Select Edit from the menu. The Change a bookshelf dialog box appears.

3. Edit the name of your bookshelf.

4. ClickOK. The bookshelf name has been updated.

Deleting a Bookshelf
Perform the following steps to delete a bookshelf:

Note: You must remove all albums from the bookshelf before performing a delete.

1. Hold your mouse over the bookshelf and click the drop-down arrow. A pop-upmenu appears.
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2. Select Delete from the menu. A dialog box appears asking you to confirm.

3. Click Yes.

4. The bookshelf is removed from the list.

Using the Work Area

TheWork Area serves as a clipboard between the Media Library and the Album views, and is acces-
sible from all locations. The Work Area is extremely useful when working with albums.

You can drag items from the Work Area into albums. The Share button provides many options for
the images within the Work Area, including sending to Storybook, adding to albums or tags, print-
ing, exporting, e-mailing, and creating a slide show. The Work Area is available in the Media Library
and both Album screens. 

l Work Area Options
l Using the Work Area to Build an Album
l Sharing Journaling Boxes Across Albums

Options
There are five option buttons within the Work Area:
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Share: This button opens amenu allowing you to view the Work Area contents as a slide show,
print the contents, e-mail the contents, or export the contents. From this menu you may also add
to albums and tags.

Clear: Removes all images from the Work Area. However, images are not removed from your
albums or library, only the Work Area.

View: TheWork Area also includes three view options. These options adjust the size of the
thumbnails displayed in the Work Area. This is helpful when you are working with a large number
of images.

Using the Work Area to Build an Album
If you want to add images from the Work Area, perform the following steps:

1. Within the Media Library, select the images you wish to place in the album by holding the CTRL
key on your keyboard and clicking the images. If you wish to select all of the images you currently
have displayed, right-click on an image and choose Select All. Selected images are highlighted in
gray within the Media Library or an album.

Tip: You may also select all displayed items by pressing CTRL-A on your keyboard.

Note:While you may place audio and video in the clipboard and in an album, they will only display
as thumbnail icons. Historian does not play or print audio and video files.

2. Click on a selected image and drag your mouse to the Work Area. When your mouse is over the
Work Area, you will see a tag icon.

Tip: Drag an item by clicking on the photo with the left mouse button. Hold down the mouse but-
ton while pulling the item to the Work Area.

3. Let go of the images by releasing the left mouse button. The images appear in the Work Area.
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4. Repeat this step for any additional images you want in your new album.

Tips:

l You may grab any photos in your Media Library. You do not have to pull out of only one cat-
egory. You can also use the Timeline to grab older items.

l To dragmultiple items to the Work Area, press the CTRL key on your keyboard while select-
ing the photos.

l Drag an image by clicking on the photo with the left mouse button. Hold down the mouse
button while pulling the photo to the Work Area.

5. Select theMy Albums tab to open the Bookshelves view.

6. Follow the steps in Adding Albums to complete your album.

Sharing Journaling Boxes
You can also use the Work Area when you wish to use the same journaling box in multiple albums.

1. Select the journaling box in your open album.

2. Drag the journaling box to the Work Area.
Tip: Drag an item by clicking on the photo with the left mouse button. Hold down the mouse but-
ton while pulling the item to the Work Area.

3. Once the journaling box is in the Work Area, you may access it from any album.

Adding Albums

Historian allows you to organize your media in the Organizer panel. However, you can tell the sto-
ries of your images by creating digital albums. Albums exist within bookshelves in the Bookshelves
panel in the Album view. You must place your items in an album and an album must exist within a
bookshelf. Create as many albums as you want within a bookshelf.
Note:While you may place audio and video in the clipboard and in an album, they will only display
as thumbnail icons. Historian does not play or print audio and video files.
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l Add an empty album
l Add an album from the Work Area
l Add an album from a tag

Add an Empty Album
There are several ways to add a new album. You may automatically generate albums using the Clip-
board or a tag, or you may create one or more empty albums.

Perform the following steps to create a new empty album:

1. Select theMy Albums tab to open the Bookshelves view.

2. Click the Create Album button on the Album ribbon.

3. The Create a new album dialog box displays. Enter a name for your new album. If you want to
change the bookshelf, select it from the drop-down menu.

4. You can select an album layout from the list of album previews. Album layouts refer to hard-
copy photo album layouts you may purchase from Panstoria.

Note: You must be connected to the Internet to follow this link.

5. ClickOK. Your new album appears in the bookshelf and opens in the Album Planning screen
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Adding an Album from the Work Area
If you want to add images from the Work Area, perform the following steps:

1. Within the Media Library, select the images you wish to place in the album by holding the CTRL
key on your keyboard and clicking the images. If you wish to select all of the images you currently
have displayed, right-click on an image and choose Select All. Selected images are highlighted in
gray within the Media Library or an Album.

Tip: You may also select all displayed items by pressing CTRL-A on your keyboard.

2. Click on a selected image and drag your mouse to the Work Area.

Tip: Drag an item by clicking on the photo with the left mouse button. Hold down the mouse but-
ton while pulling the item to the Work Area.

3. Let go of the images by releasing the left mouse button. The images appear in the Work Area.

4. Repeat this step for any additional images you want in your new album.

Tips:

l You may grab any photos in your Media Library. You do not have to pull out of only one cat-
egory. You can also use the Timeline to grab older items.

l To dragmultiple items to the Work Area, press the CTRL key on your keyboard while select-
ing the photos.

l Drag an image by clicking on the photo with the left mouse button. Hold down the mouse
button while pulling the photo to the Work Area.

5. Select theMy Albums tab to open the Bookshelves View.

6. Click From the work area on the Album Ribbon.

7. The Create a new album dialog box appears. Enter a name for your new album and select a book-
shelf from the drop-down menu.
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8. You can select an album layout from the list of album previews. Album layouts refer to hard-
copy photo album layouts you may purchase from Panstoria.

Note: You must be connected to the Internet to follow this link.

9. ClickOK. Your new album appears in the bookshelf and opens in Albums View.

Add an Album from a Tag
If you want to add images from a tag, perform the following steps:

1. Select the My Albums tab to open the Bookshelves View.

2. Click From tagged images on the Album ribbon. The Select a tag dialog box appears.
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3. Select the tag that you wish to turn into an album. Choose Select. The Create a new album
dialog box appears.

4. Enter a name for your new album and select a bookshelf from the drop-down menu.

5. You can select an album layout from the list of album previews. Album layouts refer to hard-
copy photo album layouts you may purchase from Panstoria.

Note: You must be connected to the Internet to follow this link.

6. ClickOK. Your new album appears in the bookshelf and opens in the Album Planning screen.

Opening Albums

When you create a new album within a bookshelf, the album is displayed on the Albums view to
the right of the bookshelves. To view the contents of any album, double-click the album name. You
may also hold your mouse over the album name and click the drop-down arrow to view other
options. 
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Editing and Deleting Albums

Once you have added an album to your collection, you may edit and delete it.

l Editing Albums
l Deleting Albums

Editing an Album

Perform the following steps to edit an album:

1. From within the My Albums screen, select the drop-down area to the right of the album.

2. From the resulting pop-upmenu, select Rename or move.

3. The Edit an album dialog box appears. Edit the name and/or description of your album. You may
also choose a new bookshelf from the drop-down menu.

4. ClickOK. The album is updatedwith your changes.

Deleting an Album

Perform the following steps to delete an album:

Note: You must remove all photos from the album before performing a delete.

1. From within the My Albums panel, select the drop-down area to the right of the album.

2. From the resulting pop-upmenu, select Delete album.
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3. A dialog box appears asking you to confirm. Click Yes.

4. The album is removed.

Choosing Album Layouts

You can choose to plan your album and assign a specific book type to it later. While you cannot pur-
chase an album book directly through the Historian software, the Album Planning screen allows
you organize your photos in the way you would like.

You can choose your album layout in the New Album dialog box (refer to Adding Albums for more
information) or by clicking the Change Layout button in Album View.

Tip: Historian will attempt to download new album layouts daily.
You will see a "Downloading" message and you must have an Internet connection.

The Select Layout dialog box appears. This dialog box is duplicated in the Layout section of the New
Album dialog box.

For more information on each layout, click the layout name andGet more information on this
product.
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Note: You'll be taken to the Panstoria web site to learn about each layout. An Internet connection
is required.

Cropping Album Photos

You may also crop photos so that they better fit on the album page.When you crop a photo in an
album, it only affects that book and does not affect the photo within your Media Library.

Note: Cropping within an album is only available within the PicFolio album layouts.

To crop a photo within an album, complete the following steps:

1. Place your mouse over the image and select the drop-down arrow.

2. From the pop-upmenu, select Crop.
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3. The Crop Image for Album dialog box appears. Resize the image appropriately.

4. Click OK. The image is cropped for this album only.

Note: This cropping does not affect the image as displayed in your Media Library.

Adding Journaling Boxes to Your Album

Once you have built an album, you may want to add journaling boxes. Journaling boxes allow you
to describe the people, places, and feelings associated with your images.

1. Select the photo that you want to describe with the journaling box.

2. Select the Journal ribbon and click Journal. A journaling box appears.
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3. The journaling box appears to the left of the selected image.

4. Double-click the journaling box and enter a title and descriptive text for your journaling box.

5. Click Accept. The journaling box appears to the left of the selected image.

6. You can edit the journaling box at any time from the Journaling ribbon, includingmodifying the
font, color, margins, and background.

7. If you are unhappy with the location, drag your journaling box to the desired location in the
album.

8.When you print your album, your journaling box will be included in the printing.

9. If you need to edit your journaling box, simply double-click the entry in the Album.

Modify the Default Journaling Box Appearance

You can set the default style for all journaling boxes.

1. Insert a journaling box and format it to your liking.

2. Right-click the journaling box and select Styles and formatting > Set this style as the
default.
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3. The default style for all journaling boxes is now set.

Closing and Saving Albums

Once you have workedwith your albums, you can close and save them to work with later.

Perform the following steps to save and/or finish an album:

1. You may save your album at any point. Click Save at the top of the Album Planning screen.

Tip: It is good practice to save your work often.
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2.When you are finishedworking with your album, click the Close at the top of the Album Plan-
ning screen. You will return to Bookshelf view. You can also exit by closing the album tab.

Using Empty Space

Sometimes you may want to add or remove empty space in your album to better express your
story. Empty spaces might also be used as placeholders for images you do not yet have available or
for journaling boxes you have not yet written. You can also turn an empty space into a journaling
box.

l Add an empty space
l Remove an empty space

Note: Empty spaces are not available in the Album Planner layout.

To add an empty space in your album, complete the following steps:

1. Hold your mouse over the image that you want to follow the empty space and click the drop-
down arrow. A pop-upmenu appears.

2. Select Insert empty space from the menu. The empty space appears before the photo you
selected.
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To remove an empty space or turn it into a journaling box, perform the following steps:

1. Hold your mouse over the empty space and click the drop-down arrow. A pop-upmenu appears.

2. To remove the empty space, select Remove empty space. To turn it into a journaling box,
selectMake into a journaling box.

3. Either the empty space is removed or the Journaling Box dialog box appears.

Printing an Album

You may print your entire album, including journaling boxes. You have several different options
when printing to your local printer. You can print a single image, multiple images, photo packages,
and contact sheets.

To print your album, perform the following steps:

1. Click File > Print.

2. Select Print again.

Note: You may see a low pixel warning. This means that your image has a low dots-per-inch
count and therefore may not print well. You can change this by changing the size you are printing.
For instance, you may want to choose to print a 3 x 5 image instead of a 5 x 7. You will make this
adjustment in the Layout section of the Print on local printer dialog box.

3. The Print Local dialog displays. The printer drop-down list shows a selection of available printers.
Select your printer from the list.

Tip: Your default printer will appear as the selected printer. Change this setting only if you would
like to print to a different printer.

4. If necessary, modify the settings by clicking the Printer Properties link. An options box specific to
your printer will appear. (For more information on these options, refer to your printer doc-
umentation.)

5. Review the current layout in the preview pane. If you prefer a different layout, click the drop-
down arrow.
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Learn about different print layouts, including photo packages and contact sheets.

Option Layout

Custom Sizes: Includes fit to page and custom. For
a custom size, you will enter the width and height.

Basic Prints, US: This includes standard print sizes
in the U.S., including 3x5, 4x6, 5x7, and 8x10.

Copyright © 2005-2013 Panstoria, Inc. 211



Chapter 8

Option Layout

Basic Prints, International: This includes stand-
ard print sizes for countries other than the U.S.

Photo Packages, US: A photo package is one page
containing one unique image in multiple sizes. If you
select multiple images, each image will have its own
page within a photo package. Photo packages are in
standard U.S. sizes.
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Option Layout

Photo Packages, International: A photo package
is one page containing one unique image in multiple
sizes. If you select multiple images, each image will
have its own page within a photo package. Photo
packages are in standard sizes for countries other
than the U.S.

PicFolio Album Prints: PicFolio pages fit perfectly
with Panstoria PicFolio albums.

Contact Sheets: A contact sheet displays thumb-
nails of your selected images. When you have
images developed at an image lab, you may receive
a contact sheet displayingminiature photos (thumb-
nails) of each developed image. Contact sheets are
useful when organizing and sorting physical photos.

6. Click the Print Layout option that best fits your needs. You will be returned to the Print on local
printerwindow. The preview pane displays your new layout.
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7. Choose the number of times to print each image.

Note: Layout will vary. If you have chosen a layout that accommodates more than one image per
page, Historian will print multiple copies of your image on the page. If you have chosen a layout
that accommodates only one image per page andwish to have multiple copies of your image, His-
torian will sendmultiple pages to the printer.

8. Choose the appropriate cropping option for your images. Cropping adjusts the centering and
white space around the image.

Fit in Frame Crop Fill Frame Crop
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9. In the Images to Print section, choose the appropriate option:

l All: Prints all images displayed in the current view. To learn more about views, refer to
Applying Views.

l Selected: Prints the selected images only

10. Click Print to send your image to your selected printer.
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Sharing Images and Albums
Sharing Your Memories

In addition to printing, you may want to share your memories in other ways. Historian allows you
to export your media, e-mail your media to family and friends, and create an image slide show. You
can share your memories anywhere Share options are present.

You can access Share options from many locations within the software, including the Work Area,
the File tab, the Album ribbon and the Share ribbon.

Learn more about sharing to the following:

l File
l CD/DVD
l Email
l Slideshow
l Windows Movie Maker
l Other (Flickr, Facebook, Picasa)
l Sharing to Artisan

Sharing to a File

You can export your media to a file or a directory. This is a great way to send items directly to a com-
patible external device, such as an iPod®.

You can access Share options from many locations within the software, including the Work Area,
the File tab, the Album ribbon and the Share ribbon.

Sharing to a File
Note: The original file and any revisions remain in your library. You are exporting a copy of the
selected file.

1. From the Share option, select File. The Export Items dialog box opens.

Note: The items you export vary depending on the view in which you are working. If you are work-
ing within an album, you may export an entire album or selected items. If you are working in the
Media Library, you may export a selected item, a group of selected items, or your entire library.

2. Click the appropriate radio button:
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l All for all items in the displayed tag.
l Selected for the single selected item.

Note: If you are exporting from an album and select All, you will also export any journaling boxes
within your album. Journaling boxes are exported as JPG files.

Tip: Click Select to view andmodify the selected items.

3. If you wish to save to a tag on your computer, click to browse to the location where you wish
to save the file.

4. ClickOK. The file is exported to the new location.

Advanced Options
1. Select Show Advanced Options in the Export Items dialog box.

2. Select the file-naming option that best fits your needs.

l Current filename.
l Item Properties name.
l Sequentially numbered names that start with displays a field for you to enter the file name
prefix of your choice.

3. Select if you want to copy the files unchanged from the media vault. If checked, then
your files are copied from the vault with no changes outside of specified file name changed. This
option also retains format, including that of RAW and TIFF files.
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4. Select the image size you wish to export from the image size drop-down list.

Note: A small image size, such as Small E-Mail, is better suited to compatible external devices
such as the iPod®.

5. Select the image size you wish to export. You can choose to export all of your images as one
size, for instance, 4x6.

6. ClickOK to export your file.

Sharing to CD/DVD

You can export your media to a CD or DVD.This is a great way to share files with relatives and
friends who have limited Internet access.

Note: You must have a CD/DVD burner to use this option.

You can access Share options from many locations within the software, including the Work Area,
the File tab, the Album ribbon and the Share ribbon.

Export to a Disc
Note: The original file and any revisions remain in your library. You are exporting a copy of the
selected file.

1. From the Share option, select CD/DVD. The Export Items dialog box opens.

Note: The items you export vary depending on the view in which you are working. If you are work-
ing within an album, you may export an entire album or selected items. If you are working in the
Media Library, you may export a selected item, a group of selected items, or your entire library.
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2. Select the correct disc drive from the drop-down list. For more burning options, clickOptions.

Learn more about CD/DVD drive options.

l Choose your recordingmethod, including Disc-at-Once (Closed), Track-at-Once (Closed)
and Track-at-Once (Open). Options are the same for both CD and DVD.

l ClickOK to return to the Export to CD/DVD dialog box.

3. Click the appropriate radio button:

l All for all items in the displayed tag.
l Selected for the single selected item.

Note: If you are exporting from an album and select All, you will also export any journaling boxes
within your album. Journaling boxes are exported as JPG files.

Tip: Click Select to modify and select the items.

3. Make sure the appropriate drive is selected and that a blank disc is in the drive.

Note: If you are burning a DVD, you must use a DVD burner and a DVD disc.

4. ClickOK. The file is burned to the selected disc.

Advanced Options
1. Select Show Advanced Options in the Export Items dialog box.
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2. Select the file-naming option that best fits your needs.

l Current filename
l Item Properties name.
l Sequentially numbered names that start with displays a field for you to enter the file name
prefix of your choice.

3. Select if you want to copy the files unchanged from the media vault. If checked, then your files
are copied from the vault with no changes outside of specified file name changed. This option also
retains format, including that of RAW and TIFF files.

If this is not checked, images will be converted to JPG format.

4. Select the image size you wish to export from the image size drop-down list.

Note: A small image size, such as Small E-Mail, is better suited to compatible external devices
such as the iPod®.
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5. Select the image size you wish to export. You can choose to export all of your images as one
size, for instance, 4x6.

5. ClickOK to burn your data.

Share to E-mail

You can e-mail your media to family and friends using the Share option. You can access Share
options from many locations within the software, including the Work Area, the File tab, the Album
ribbon and the Share ribbon.

E-mail Your Media
Note: The original file and any revisions remain in your library. You are exporting a copy of the
selected file.

1. From a Share option, select Email. The Email Items dialog box opens.

Note: The items you export vary depending on the view in which you are working. If you are work-
ing within an album, you may export an entire album or selected items. If you are working in the
Media Library, you may export a selected item, a group of selected items, or your entire library.

2. Click the appropriate radio button:

l All for all items in the displayed tag.
l Selected for the single selected item.

If you do not have an item selected, the option will default toAll and all items in the tag will be
sent.

Tip: Click Select to modify and select the items.

3. Select your e-mail provider. The drop-down list includes the following:
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l Default: This launches the default e-mail program on your computer, such as Microsoft
Outlook. If you want to use your default program, leave this option selected.

l Specific Accounts: Any web-based email accounts you may have added are also listed. To
learn more about adding email accounts to Historian, refer to Add an Email Account.

4. ClickOK. The E-mailing Imagesmessage box displays as Historian launches your e-mail pro-
gram.

5. A blank message will appear with a standard signature line and the image file(s) attached. Add a
recipient, any message, and click Send.

6. Historian displays an E-mail Completemessage. Click Close.

Advanced Options
1. Select Show Advanced Options in the E-mail Items dialog box.

2. Select the file-naming option that best fits your needs.

l Same as the current file name retains the current file name.
l Same as the name shown in Image Details uses the information in the Name: line of the
Item Details panel.

l Use sequentially numbered names that start with displays a field for you to enter the file
name prefix of your choice.

3. Select the item size you wish to e-mail from the image size drop-down list. It is recommended to
choose E-mail or Web sizes. This decreases the file size of the image andmakes it easier for many
people to receive.
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4. Select the image size you wish to e-mail. You can choose to e-mail all of your images as one size,
for instance, 4x6.

5. Click OK to e-mail your file.

Add an Email Account

You can add email accounts for sharing. The application automatically includes MAPI email
accounts, such as those in Microsoft Outlook. These steps guide you in setting upweb email
accounts such as Gmail, Yahoo, and Hotmail.

Note: Accounts must have an open interface to their SMTP servers. Your SMTP settings are avail-
able from your email provider.

1. Click Edit Accounts.

2. The Software Options dialog opens to the Email settings. Click Add.
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3. The New Email Account dialog displays. Fill in the requested information, making sure to choose
the appropriate option from the drop-down list.

Note: You must provide your password to access your email from Historian. Your password is
stored in an encrypted file on your local machine and is not sharedwith anyone.

If you choose Other email, you will have tomanually add your SMTP settings.

View the Other email settings dialog box.

4. Once you have added your account information, click OK.

Note: After editing custom settings, the software attempts to communicate with your email
server to ensure the settings work. This causes a slight delay when you clickOK.

5. Historian sets up your email.

Note: If the software is unable to connect using the specified settings,you will be asked if you want
to confirm the settings regardless.

You can add, remove and edit your email settings in the Email section of the Software Options
dialog box.

Creating a Slide Show

Historian allows you to create a slide show from selected images to show on your computer.
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You can access Share options from many locations within the software, including the Work Area,
the File tab, the Album ribbon and the Share ribbon.

1. Select Slideshow from the Share option. The Start Slide Show dialog box appears.

2. Select which images you want to display in your slide show:

l All:Displays all images in the selected tag.
l Selected: Displays only the images you have selected.

Tip: Click Select to modify and select the items.

3. Select the Style for your slide show.

4. Select other options for your slide show:

l Show image captions: Displays the image name.
l Repeat when done: Runs the slide show in a continuous loop.
l Delay: Sets the delay between images in the slide show.
l Background music: Select an audio file to play throughout your slide show.

5. ClickOK.

6. The first selected image fills your screen. Click the screen. The slide show toolbar appears across
the bottom of the screen.

Note: You may toggle the visibility of the toolbar by clicking or by using the ESC key on your key-
board.

7. Adjust your timing, if necessary, in the slide show toolbar.

8. The slide show will switch photos automatically or you may use the Forward and Back buttons to
navigate through the slide show. The Exit button exits the slide show. The Pause button holds
your slide show at a particular moment. Click Pause again to restart the slide show.
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Sharing to Windows Movie Maker

You can export your media toWindows Movie Maker.

You can access Share options from many locations within the software, including the Work Area,
the File tab, the Album ribbon and the Share ribbon.

Note: This option is not available in some instances:

l You must be runningWindows Vista or Windows 7.
l You must have a recent version of Windows Movie Maker.

Sharing to Movie Maker
Note: The original file and any revisions remain in your library. You are exporting a copy of the
selected file.

1. From the Share option, selectMovie Maker. The Export Items dialog box opens.

Note: The items you export vary depending on the view in which you are working. If you are work-
ing within an album, you may export an entire album or selected items. If you are working in the
Media Library, you may export a selected item, a group of selected items, or your entire library.

2. Click the appropriate radio button:

l All for all items in the displayed tag.
l Selected for the single selected item.

Note: If you are exporting from an album and select All, you will also export any journaling boxes
within your album. Journaling boxes are exported as JPG files.

Tip: Click Select to view andmodify the selected items.

3. If you wish to save to a tag on your computer, click to browse to the location where you wish
to save the file.

4. ClickOK. The files are exported to Movie Maker.
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Advanced Options
1. Select Show Advanced Options in the Export Items dialog box.

2. Select the file-naming option that best fits your needs.

l Current filename.
l Item Properties name.
l Sequentially numbered names that start with displays a field for you to enter the file name
prefix of your choice.

3. Select the image size you wish to export from the image size drop-down list.

Note: A small image size, such as Small E-Mail, is better suited to compatible external devices
such as the iPod®.

4. Select the image size you wish to export. You can choose to export all of your images as one
size, for instance, 4x6.

5. ClickOK to export your file.

Sharing to Other (Flickr, Facebook, Picasa)

You can share to several different social sites, including Flickr, Facebook, and Picasa.

You must have an account with one of these sites in order to share your photos with your friends.
Accounts with all three sites are free.

l Flickr: Flickr is a photo sharing site that stores your photos and allows you to rate, share and
comment upon your photos and those of your friends.

l Picasa: Picasa is an online photo album and photo storage site with social features.
l Facebook: Facebook is the world's largest social network and includes many options for
photo and video sharing.

Note: Personal privacy options within each site may affect your ability to share photos.

You can access Share options from many locations within the software, including the Work Area,
the File tab, the Album ribbon and the Share ribbon.
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Sharing to social media sites can be found in theOthermenu in many of the Share option loca-
tions.

Sharing to Social Media
The process for sharing to social media sites is similar across all three options: Flickr, Facebook and
Picasa.

Note: The original file and any revisions remain in your library. You are exporting a copy of the
selected file.

1. From the Share option, select Flickr, Facebook or Picasa. The Share to dialog box opens.

Note: The items you export vary depending on the view in which you are working. If you
are working within an album, you may export an entire album or selected items. If you are
working in the Media Library, you may export a selected item, a group of selected items, or
your entire library.

2. Click the appropriate radio button:
l All for all items in the displayed tag.
l Selected for the single selected item.

Note: If you are exporting from an album and select All, you will also export any journaling
boxes within your album. Journaling boxes are exported as JPG files.

Tip: Click Select to view andmodify the selected items.
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3. If you wish to save to a tag on your computer, click to browse to the location where you
wish to save the file.

4. ClickOK. The Historian Connector for that site displays.

5. You may be asked to log into your account on the social media site.

6. Depending on the site, you may be asked to confirm that Historian may access your
account.

7. Your media is uploaded to the social media site and you can now share with your friends and
family.

Advanced Options
1. Select Show Advanced Options in the Export Items dialog box.
2. Select the file-naming option that best fits your needs.

l Current filename.
l Item Properties name.
l Sequentially numbered names that start with displays a field for you to enter the file
name prefix of your choice.

3. Select the image size you wish to export from the image size drop-down list.
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4. Note: A small image size, such as Small E-Mail, is better suited to compatible external
devices such as the iPod®.

5. Select the image size you wish to export. You can choose to export all of your images as one
size, for instance, 4x6.

6. ClickOK to export your file.

Sharing to Artisan

Artisan is a secondary application that is available. In order to use the Artisan options in the Share
menu, youmust have Artisan installed on your machine.

Artisan allows you to design creative photo albums in sporty covers. You can send any number of
items to Artisan from Historian , and use those items to create your special, hard copy photo
album.

You can access Share options from many locations within the software, including the Work Area,
the File tab, the Album ribbon and the Share ribbon.

Note: Share to Artisan can be found in theOthermenu in many of the Share option locations.

1. Select Send photos to Artisan. The Send Items to Artisan dialog box appears.
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2. Choose one of the following:
l All: Includes all items in your album, including journaling boxes
l Selected: Select specific items, including journaling boxes, by pressing the CTRL key
on your keyboard.

Tip: Click Select to modify and select the items.

3. When you have assigned items to Artisan, clickOK.
4. The Artisan Connector dialog displays.

5. Choose whether you are adding to a new Artisan project or a currently open project. Click
OK.

6. Artisan launches. You can then create your new project.

Advanced Options 
1. Select Show Advanced Options in the Send photos to Artisan dialog box.
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2. 2. Select the file-naming option that best fits your needs.
l Current filename.
l Item Properties name.
l Sequentially numbered names that start with displays a field for you to enter the file
name prefix of your choice.

3. Select the image size you wish to export from the image size drop-down list.

Note: A small image size, such as Small E-Mail, is better suited to compatible external
devices such as the iPod®.

4. Select the image size you wish to export. You can choose to export all of your images as one
size, for instance, 4x6.

5. ClickOKto share to Artisan.
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Printing Images and Albums
Printing to a Local Printer

You have several different options when printing to your local printer. You can print a single image,
multiple images, photo packages, and contact sheets.

1. Select the images you want to print by holding the CTRL key on your keyboard and clicking the
images. If you wish to select all of the images you currently have displayed, right-click on an image
and choose Select All. Selected images are highlighted in gray within the Media Library or an
Album.

For more information on printing an album, refer to Printing an Album.

2. From the File tab, select Print > Print.

Note: You may see a low pixel warning. This means that your image has a low
dots-per-inch count and therefore may not print well. You can change this by chang-
ing the size you are printing. For instance, you may want to choose to print a 3 x 5
image instead of a 5 x 7. You will make this adjustment in the Layout section of the
Print on local printer dialog box.

3. The Print Local dialog displays. The printer drop-down list shows a selection of available printers.
Select your printer from the list.

Tip: Your default printer will appear as the selected printer. Change this setting only if you would
like to print to a different printer.

4. If necessary, modify the settings by clicking the Printer Properties link. An options box specific to
your printer will appear. (For more information on these options, refer to your printer doc-
umentation.)

5. Review the current layout in the preview pane. If you prefer a different layout, click the drop-
down arrow.
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Learn about different print layouts, including photo packages and contact sheets.

Option Layout

Custom Sizes: Includes fit to page and custom. For
a custom size, you will enter the width and height.

Basic Prints, US: This includes standard print sizes
in the U.S., including 3x5, 4x6, 5x7, and 8x10.
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Option Layout

Basic Prints, International: This includes stand-
ard print sizes for countries other than the U.S.

Photo Packages, US: A photo package is one page
containing one unique image in multiple sizes. If you
select multiple images, each image will have its own
page within a photo package. Photo packages are in
standard U.S. sizes.
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Option Layout

Photo Packages, International: A photo package
is one page containing one unique image in multiple
sizes. If you select multiple images, each image will
have its own page within a photo package. Photo
packages are in standard sizes for countries other
than the U.S.

PicFolio Album Prints: PicFolio pages fit perfectly
with Creative Memories PicFolio albums.

Contact Sheets: A contact sheet displays thumb-
nails of your selected images. When you have
images developed at an image lab, you may receive
a contact sheet displayingminiature photos (thumb-
nails) of each developed image. Contact sheets are
useful when organizing and sorting physical photos.

6. Click the Print Layout option that best fits your needs. You will be returned to the Print on local
printerwindow. The preview pane displays your new layout.
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7. Choose the number of times to print each image.

Note: Layout will vary. If you have chosen a layout that accommodates more than one image per
page, Historian will print multiple copies of your image on the page. If you have chosen a layout
that accommodates only one image per page andwish to have multiple copies of your image, His-
torian will sendmultiple pages to the printer.

8. Choose the appropriate cropping option for your images. Cropping adjusts the centering and
white space around the image.

Fit in Frame Crop Fill Frame Crop
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9. In the Images to Print section, choose the appropriate option:

l All: Prints all images displayed in the current view. To learn more about views, refer to
Applying Views.

l Selected: Prints the selected images only

10. Click Print to send your image to your selected printer.

Note:Historian displays a message asking if you would like to mark the uploaded photos as printed.
ChoosingYes affects which photos are available via the PrintTrack™ option in the Organizer Panel.
For more information, refer toApplying Views.

Low Pixel Warning
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You may see a low pixel warning. This means that your image has a low dots-per-inch count and
therefore may not print well. You can change this by changing the size you are printing. For
instance, you may want to choose to print a 3x5 image instead of a 5x7. You will make this adjust-
ment in the Layout section of the Print on Local Printer dialog box.

Choose a Print Layout

In the Print on Local Printer dialog box, review the current layout in the preview pane. If you prefer
a different layout, click the drop-down arrow.

Choose from one of the layout options:

Option Layout

Custom Sizes: Includes fit to page and custom. For
a custom size, you will enter the width and height.
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Option Layout

Basic Prints, US: This includes standard print sizes
in the U.S., including 3x5, 4x6, 5x7, and 8x10.

Basic Prints, International: This includes stand-
ard print sizes for countries other than the U.S.
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Option Layout

Photo Packages, US: A photo package is one page
containing one unique image in multiple sizes. If you
select multiple images, each image will have its own
page within a photo package. Photo packages are in
standard U.S. sizes.

Photo Packages, International: A photo package
is one page containing one unique image in multiple
sizes. If you select multiple images, each image will
have its own page within a photo package. Photo
packages are in standard sizes for countries other
than the U.S.
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Option Layout

PicFolio Album Prints: PicFolio pages fit perfectly
with Panstoria PicFolio albums.

Contact Sheets: A contact sheet displays thumb-
nails of your selected images. When you have
images developed at an image lab, you may receive
a contact sheet displayingminiature photos (thumb-
nails) of each developed image. Contact sheets are
useful when organizing and sorting physical photos.

Choose the Print Layout option that best fits your needs. You will be returned to the Print on
local printerwindow. The preview pane displays your new layout.

Print to a Web Provider

There are many web-based image-printing labs. If you currently use an existing provider, you can
print directly to that web-based provider using Historian.

To print to an existing web-based provider, perform the following steps:

1. Select the images you want to print by holding the CTRL key on your keyboard and clicking the
images. If you wish to select all of the images you currently have displayed, right-click on an image
and choose Select All.
Tip: You may also select all displayed items by pressing CTRL-A on your keyboard.

2. From the File tab, choose Print >Print at web-based photo provider.
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3. The Print at Web Provider dialog box appears. Enter the URL for the print provider.
Example: http://www.myprintprovider.com

Click the appropriate radio button:  

l All for all items in the displayed tag.
l Selected for the single selected item.

Tip: Click Select to view andmodify the selected items.

4. ClickOK. Historian will launch a smallImages to Print window containing the images you wish to
print. Historian will also launch your default browser, displaying the Web address you specified.
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6. You may need to log in to the print provider. If the print provider has drag-and-drop capabilities,
you may drag and drop your images onto the print provider Web site.

7. When you have finishedwith the Images to Print window, click Close.

Note:Historian displays a message asking if you would like to mark the uploaded photos as printed.
ChoosingYes affects which photos are available via the PrintTrack™ option in the Organizer Panel.
For more information, refer toApplying Views.
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Managing Your Vault
Understanding the Media Vault

Your media are stored in a media vault. Like any vault, you can keep adding to it, ensuring that
your favorite items are organized and protected. The vault is like keeping all of your photos,
albums, and newspaper clippings in one box or cabinet in your home— safe, protected, and easy to
access. When you want to see an item or share it, you only have to access one location.

The vault is a folder on your hard drive that contains a set of folders and files. These folders contain
all the original files, revisions, descriptions, categories, albums, journal boxes and items that you
create in Historian .

All media brought into Historian are copied into a vault. When you back up your vault, you are back-
ing up everything necessary to completely restore your vault if it becomes damaged or lost.

Your media libraries are stored in vaults for preservation. You should access the Vault ribbon peri-
odically to perform routine maintenance. Backing up and running diagnostics on your vault keeps
your media in great condition.

Media Library
You view the items in your vault within the Media Library. The Media Library is organized using the
Organizer Panel. Within the Organizer Panel are categories and tags. Categories contain tags. For
instance, you may have a category calledWeddings. Within the Weddings category, you may have
a tag namedOur Wedding. Think of categories as the equivalent to a physical box of photos, organ-
ized according to topic.

Organization
Categories and tags are just one of the many ways you may view your items. You may also view
them by date. The Timeline goes back centuries. For instance, you could classify an image of
the Tower of London on the date you took the image. You could also view it based on the estimated
date the Tower of London was built.

Ratings are another way to view and sort your media. Within the Media Library, you can assign a
rating of one to five stars to each item. You can then sort and view only items with a specified rat-
ing.

Albums
Albums allow you to tell the stories in your images. Use your imagination when creating albums.
You may arrange images in an album in any order you wish, even adding journal entries to
describe each image. Albums are the digital versions of the scrapbooks on your shelves.

Managing Your media vault

Using the vault, you can monitor the size and health of your library. It is important to view this
information periodically. You can adjust the size of your thumbnail cache and permanently delete
files from your vault Recycle Bin.

Perform the following steps to access and use the vault information:

1. Click the Welcome tab .

2. Click File > Properties.

3. Themedia vault Properties dialog box displays.
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View General options.

Options Descriptions
General:

l Name
l Size
l Location
l Facial Recognition

The General tab gives you basic infor-
mation about your vault. You can mod-
ify the name of your vault and enable
Facial Recognition features.

Home View

You can set the Home View of your
media vault here. For more infor-
mation on setting the Home View,
refer to Displaying Home View

Once you've set the Home view, you
can choose the default date range to
display in the drop-down box.

Start View

Choose what view you prefer when
you first open amedia vault: 

l customized Home view
l last view you usedwithin that
vault.

View Statistics.
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The Statistics screen displays all the relevant statistics regarding your media vault.

l Images: Displays number of images, number of revisions, number of items not printed,
and ratings.

l Media: Displays number of audio and video files.
l Containers: Displays number of tags, folders/categories, albums and bookshelves

View Health Status options.

This screen lets you know what items in your media vault are healthy, what items deserve
another look, andwhat items are corrupt or critical. You can choose to Ignore issues from this
screen, resetting the media vault to healthy.

For more information, refer to Keeping Your Vaults Healthy.

View Backup options.
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This screen displays all the information about backups and pending backups including last dates,
queued items, aged items, andwhat might be pending. The top option allows you tomark the
entire media vault for backup.

View Support options.

Options Descriptions

Thumbnails

l Use the slider to set the maximum disk
space to use for thumbnails.

l Clear all the thumbnails and regenerate by
clickingClear Thumbnails.

Vault recycle bin
Empty or show the recycle bin.

Note: Emptying the recycle bin permanently
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Options Descriptions
deletes items from the media vault.

For more information, refer to Undeleting Items.

Temporary Files

Sometimes temporary files are created in Win-
dows. These may take up extra space on your
hard drive. ClickDelete Temporary Files to
remove any temporary files created by Historian.

4. Click Close to exit the dialog box.

Assign a Vault Preview Image

You can assign a preview image to your vault. When you have multiple vaults, this can make it eas-
ier to quickly identify each one. To add a preview image to a vault, perform the following steps:

1. In the Media Library, select the image you want to use as your preview.

2. Click the drop-down arrow. From the resultingmenu, choose Tools, then Set as vault pre-
view image.
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3. Click theWelcome tab. The vault preview image should be displayed.
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Open a media vault

Several media vault options are available from the Home ribbon of the Welcome tab.

Tip: Many of these items are also available from the File tab.

You can open amedia vault when you launch the application or at any time when you want to
switch vaults.

1. ClickOpen another vault. The Select a folder containing ... dialog box displays.

Note: You may also click the Filemenu and select Open.

2. Browse to the location of your media vault. Once you located the vault, click Select Folder.

3. The new vault opens.

Create a New Vault

Several media vault options are available from the Home ribbon of the Welcome tab. 

Tip: Many of these items are also available from the File tab.
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Each member of your family may want their own media vault in which to preserve their images. If
you want to create more than one vault, perform the following steps:

1. Click Create new vault. The New media vault dialog box displays.

2. Enter the name of your new vault.

3. Select a location for your vault.

l Shared documents (everyone): Placing your vault in your Shared Documents folder
allows everyone who accesses your computer to access your vault.

l My documents (Just for me): This option places your vault in your My Documents
folder within Windows. Your My Documents folder is only accessible when you are logged on
to your computer.

l Other folder: This option allows you to specify where on your machine you wish to store
your new vault. This option is particularly useful when storing your vault on an external or
network drive.

4. Choose whether or not you want to enable facial recognition for this vault.

5. You can include sample content in the vault. If you do not wish to view sample content, leave
this box unchecked.

6. ClickOK. The new vault is created. You will need to import items into the new vault. For more
information on importing items, refer to Getting Your Media.

Recover a Media Vault

Several media vault options are available from the Home ribbon of the Welcome tab. 
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Tip: Many of these items are also available from the File tab.

Occasionally you may need to recover lost files. There are several reasons this might happen,
including:

l You have purchased a new computer and need to re-install your media vaults.
l You have misplaced your vault on your machine.
l Your computer has had amalfunction and you need to recover several lost images.

It is important to routinely backup your vaults to easily recover the files when needed. The recover
function will not work if you have not backed up your vault. To perform these steps, you need to
have the following:

l Access to a Shadow Copy of your vault
l New location and drive space in which to recover your vault

1. Click Recover a Vault from the Home Ribbon of theWelcome tab.

2. The Recover dialog displays. Enter a new location for the recovered vault.

3. Choose whether to recover from a Shadow Copy or disc.

4. ClickOK. Continue following the directions on the screen until your vault has been fully recov-
ered.

Vault Ribbon

Using the Vault Ribbon

Historian makes it easy to back up your files. You can use your back up to recover lost files later, to
move a large amount of items off of your computer and free up disk space, or to re-install your
vault if you have purchased a new computer. Historian can also automatically protect your media
vault. 

Option Explanation

Vault Health

This section lets you know when
your vault was last checked and
whether or not a check is required.

The first item shows the status of
your media vault, using red, yellow,
and green icons for warnings,
notes, and all clear. Click this icon at
any time to view the status of your
vault andmake associated changes.

Click Troubleshoot and Fix to run
a Health Check. If your vault needs
repairing, Historian will attempt
repair. If your vault is healthy, a con-
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Option Explanation
firmation message confirming that
status will display.

Learn about running a Health
Check.

Backup

The Backup options let you backup
your archive incrementally or all at
once. Click the Health Status but-
ton to see if your vaults are in need
in backup.

Historian provides the option to
backup to CDs/DVDs. You must
have a CD or DVD burner and
access to several blank discs. The
first time you backup your vault to
CD/DVD, the entire vault will be
archived. For subsequent backups,
Historian will create backup discs
that contain the changes since you
last backed up the vault. Historian
tracks these changes andwill
remind you to perform a backup.

Learn about

l Writing to a CD or DVD
l Writing to a disk to burn later
l Archiving incrementally
l Creating a full backup

 Historian can also automatically pro-
tect your memories by maintaining
a shadow copy of your vault. A
shadow copy is a copy of your vault
that is automatically updatedwhen
you make changes to the original.

When Automatic Protection is ena-
bled, you will see Historian updating
the shadow copy whenever you exit
the software after making changes.
Shadow copies are best created on a
different physical hard drive. If
something happens to your original
hard drive, the shadow copy is safe
and your vault can be recovered. It
is a good idea to use both Automatic
Protection andManual Backup. The
shadow copy will always have the
latest version of your vault and the
CDs/DVDs ensure that a second
copy of your files also exists in a sep-
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Option Explanation
arate location.

Learn about automatic protection.

Tools

The Tools section provides several
options for working with your media
vault.

l Undelete: Restore files from
your vault recycle bin or
shadow copies. Learn more.

l Merge: Combine multiple
media vaults. Learn more.

l Export Vault: Export a
media vault to Windows.
Learn more.

l Watch folders: Designate
folders in Windows for His-
torian to monitor. Learn
more.

l Write item
properties: Create and
maintain metadata for items
in your vault. Learn more.

Repairing Your media vault
It's a good idea to periodically run a Health Check on your vault. There are several locations to
launch a Health Check:

l From the Welcome tab display screen:

l From the Vault ribbon in the Media Library

Click theHealth Check icon in either screen to run the check.
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Occasionally, the Health Check may discover an error in your vault. This usually happens for one of
two reasons:

l You have deleted an item from your vault outside of the Historian application.
l You have added an item to the vault files outside of the Historian application.

In order for your vault to remain healthy, you need to add and remove all files using the appli-
cation.

l To correctly remove files from Historian , refer to Deleting an Item.
l To correctly add files to Historian , refer to Getting Your Media.

To repair your vault, complete the following steps:

1. If you have errors in your vault, click the Troubleshoot and Fix button on the Vault ribbon in the
Media Library.

2. The Health check notification dialog box displays. Choose Yes, repair now to continue with the
repair.

258 Copyright © 2005-2013 Panstoria, Inc.



Managing Your Vault

Tip: Click Show details to view more information about the damaged items.
View the Health check report dialog box.

3. The Fix damaged items dialog box appears. Select an option to begin the process.
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Learn more about the options.

Option Description
Fix using the cur-
rent shadow copy

Correct the errors in your vault by referencing the current and up-to-date
shadow copy.

Fix using a dif-
ferent shadow
copy

Choose a separate shadow copy to reference when correcting your media
vault.

Fix using a backup
disc or folder

Point Historian to a backup CD/DVD or a file folder elsewhere on your hard
drive or an external drive to reference when correcting your vault.

Clean up damaged
items

Historian will try to correct the problem without referencing a backup or
shadow copy.

4. Choose Clean up damaged items to continue a repair without using a backup or shadow
copy.

Note: For more information on recovering vaults, refer to Recover a media vault.

5. Historian explains it's recovery process. It is important to note that this involves removing dam-
aged revisions and potentially the damaged originals. If you want to continue, click Yes.

6. Once Historian has made corrections, it will alert you that all items have been fixed.

7. A second dialog appears letting you know your vault is now healthy.
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8. The symbol in the Health section of the Vault ribbon changes to a green "healthy" check mark.

Creating an Incremental Backup
Historian allows you to backup your media vault to CDs/DVDs in small increments. Access Backup
features from the Vault ribbon.

You can choose an incremental backup or a full backup of all your item. An incremental backup
adds changed and/or new items to an existing backup file.

Perform the following steps to create an incremental backup:

1. From the Vault ribbon, click Incremental Backup. The Manual Protection (Backup) dialog box
will open.

3. Select a backupmethod. There are two options: 
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l Write directly to CDs or DVDs: Choose this option if you have access to a number of CDs
or DVDs and a CD or DVD burner.

l Write to a hard drive now, burn CDs or DVDs later: Choose this option if you do not
have access to CDs or DVDs, you do not have a burner, or your burner is incompatible with
Historian . The software creates folders that will fit on either a DVD or CD, per your spec-
ification, that you may transfer to disc at a later date.

Refer to any of the following to learn more about each backup option: 

l Write Directly to CD or DVD
l Write to a hard drive now, burn CDs or DVDs later

Create a Full Backup
Historian allows you to back up your media vault to CDs/DVDs. Access Backup features from the
Vault ribbon.

You can choose an incremental backup or a full backup of all your item. Perform the following steps
to back up your media to CD/DVD:

1. From the Vault ribbon, click Full Backup. The Full Backup to CD/DVD dialog box will open.

3. Select the appropriate burning device andmake sure you have a blank disc in the drive. Click
Backup.
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4. When the disc is full, Historian displays a message detailing the Backup ID and number of items
backed up. If there are more items to be backed up, you may insert another disc or continue the
backup process later. 

Note: It is important to label your backup disc with the Backup ID provided byHistorian . (In the
example above, the Backup ID is Backup0002.) Labeling your backup discs appropriately allows for
easy recovery.

Write Directly to CD or DVD
Choose this option if you have access to a number of CDs or DVDs and a CD or DVD burner. If you
do not have access to CDs or DVDs, you do not have a burner, or your burner is incompatible with
Historian , you should choose Write to a hard drive now, burn CD or DVDs later.

1. SelectWrite directly to CD or DVD from the Backupwindow. The next screen of the CD/DVD
BackupWizard appears.

2. If you have more than one CD or DVD burner, select the appropriate device from the drop-down
list.

Note: Make sure you have inserted a blank CD or DVD in your burner.

Tip: Click Select to view andmodify the selected items.

3. Click Backup. Historian will begin to burn your vault to CD or DVD.
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4. When the disc is full, Historian displays a message detailing the Backup ID and number of items
backed up. If there are more items to be backed up, you may insert another disc or continue the
backup process later.

Note: It is important to label your backup disc with the Backup ID provided by Historian . (In the
example above, the Backup ID is Backup0002.) Labeling your backup discs appropriately allows for
easy recovery.

Write to Hard Drive Now, Burn CDs or DVDs Later
Choose this option if you do not have access to CDs or DVDs, you do not have a burner, or your
burner is incompatible with Historian . Historian creates tags that will fit on either a DVD or CD, per
your specification, that you may transfer to disc at a later date. You must have sufficient space to
store the tags and files until you are able to burn the CDs/DVDs.

1. SelectWrite to hard drive now, burn CDs or DVDs later from theManual Protection
(Backup) dialog box. The next screen of the Backup to Hard Drive wizard appears.

2. Select the backup size you want to create from the drop-down menu.
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Tip: Click Select to view andmodify the selected items.

3. Browse to the location on your hard drive where you want to store the Backup Image.

4. Click Backup. Historian copies the required files to the specified directory.

5. When complete, click Close.

Using Shadow Copies (Automatic Protection)

Historian can automatically protect your memories by maintaining a shadow copy of your media
vault. If anything happens to the original vault, you can use the shadow copy. A shadow copy is a
copy of your vault that is automatically updated when you make changes. When Automatic Pro-
tection is enabled, you will see Historian updating the shadow copy whenever you exit the soft-
ware after making changes.

Shadow copies are best created on a different physical hard drive. If something happens to
your original hard drive, the shadow copy is safe and your vault can be recovered. For more infor-
mation, refer to Recovering From a Shadow Copy.

Shadow copies can be activated when you create a new vault or from the Vault ribbon.

To apply Automatic Protection, perform the following steps:

1. Select Shadow Copy from the Protect ribbon.

2. The Automatic Protection dialog box appears.
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3. Click Start protection.

4. Click the Browse button and select a location for the shadow copy. Remember that the location
must have enough space to hold your entire, and expanding, media vault.

Notes:

l You can only specify an empty folder as the location for your shadow copy.
l It is recommended to store the shadow copy on a different physical hard drive from your
original vault.

5. Once the directory is created, clickUpdate now.

Note: Every time a vault is closed or Historian is closed, the shadow copy is updatedwith changes.
A shadow copy may be Paused if the computer is going to be disconnected from the shadow copy
drive, such as a vault on a laptop. However, once protection is Stopped, it cannot be used as a
shadow copy again.

6. When the update is complete, the dialog box will display the message, "No items require updat-
ing."

7. Click Close to exit the dialog box.

Undeleting Items
When you delete an item from your vault, you are actually moving it to the vault Recycle Bin. This
functions similar to the Windows Recycle Bin, as files remain in the bin until permanently deleted.

l Restore Items from the Recycle Bin
l Permanently Delete Items
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Restore Items from the Recycle Bin

To restore items from the vault Recycle Bin, perform the following steps:

1. In the Media Library, select the Vault ribbon. Click Undelete.

2. The Restore from Vault Recycle Bin dialog displays.

Options Explanations
Undelete
using the
vault recycle
bin

The Restore from Vault Recycle Bin dialog box displays. You can select individual
items by pressing the CTRL key on your keyboard and clicking each item.

View dialog box.
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Options Explanations

Click Restore Selected Items to restore only your selections. Click Restore All
Items to restore all items in the Recycle Bin. The items are restored to your
Media Library and their vault.

Undelete
using the
current
shadow
copy

If you have already purged your recycle bin, you can still restore an item or items
from your current shadow copy. The Restore from Shadow Copy dialog box
appears.

View dialog.

Click Restore Selected Items to restore only your selections. Click Restore All
Items to restore all items displayed in the Shadow Copy. The items are restored
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Options Explanations
to your Media Library and their vault.

Undelete
using a dif-
ferent
shadow
copy

You can restore an item from you deleted from a different shadow copy. Select the
alternate shadow copy location in the Select a folder ... dialog box.

View dialog.

The Restore from Shadow Copy dialog box appears. Click Restore Selected
Items to restore only your selections. Click Restore All Items to restore all
items displayed in the Shadow Copy. The items are restored to your Media Library
and their vault.

Undelete
using a
backup disc
or tag

You can restore an item from you deleted using a backup copy. Select the backup
location in the Open amedia vault dialog box.

View dialog.
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Options Explanations
The Restore dialog box appears. Click Restore Selected Items to restore only
your selections. Click Restore All Items to restore all items displayed. The items
are restored to your Media Library and their vault.

Permanently Delete Items from the Recycle Bin

1. Click the Welcome tab. 

2. Choose Show me more details from the display area.

3. Themedia vault Properties dialog box displays. Click Support.

4. Click Empty recycle bin to permanently delete everything in the recycle bin.

5. A confirmation message appears. Click Yes to confirm or No to cancel.

6. ClickOK to exit the dialog box.

Merge Vaults
Occasionally you may want to merge your vaults. Historian 3.0 makesmerging simple.

Tomerge the contents of two vaults, perform the following steps:
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1. In the Media Library, select the Vault ribbon. Click Merge.

2. The Open a Vault dialog box displays. Choose from the list of recently used vaults or clickMore
vaults on my computer to browse for additional vaults.

3. After you select a vault, a message displays. Confirm that you want to merge the vaults into
one.

4. Historian merges your vaults.

5. A confirmation message displays when complete.

Exporting a Vault
Historian supports exporting an entire vault to Windows. Access the Export feature from the Vault
ribbon in the Media Library.

To export a vault, perform the following steps:

1. From the Vault ribbon, click Export Vault.

2. The Copy Vault dialog box displays. Enter the required information.
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Option Explanation
Copy the items to this
Windows folder

Use the Browse button to enter the file location in Windows where you
want to export the vault

Item Selection
Copy all items in the
entire vault Copy all the items in the media vault

Copy items only if cur-
rently showing in the
Media Library

Copy only the items currently displayed. For instance, if only items rated
3 stars and above are displayed in the current view, then only those
items will be copied.

File Naming
Same as the current
file name

This option specifies the file name used in the vault, such as
IMG3654.JPG.

Same as the name
shown in Item Prop-
erties

This option specifies the item name as the file name, such as Having a
Snow Day.

Items in Multiple Tags
Save only one copy
and use shortcuts in
other Windows tags.

This option saves space on your hard drive by utilizingWindows shortcuts
when an item exists in more than one tag in your vault. It only copies the
item once.

Save a copy in each
Windows tag.

This option takes upmore room, but may prove less confusing when you
are searching for the original image. This option copies the original image
into each tagwhen it exists in more than one.

Revisions

Copy all the revisions
When copying an image with multiple revisions, copy each revision,
including the original and inactive revisions. This option takes upmore
space on your hard drive.

Copy only the cur-
rently displayed
revision

When copying an image with multiple revisions, copy only the active (dis-
played) revision. This option saves space on your hard drive.

3. ClickOK. Your vault is exported toWindows.

Setting Up Watch Folders
Historian can watch assigned folders on your computer. When it senses new media in the folder, it
notifies you and offers to import the items to your Media Library.

 1. From your Media Library, select the Vault ribbon. ClickWatch Folders.

2. TheWatch Folders dialog box displays. Click Add to set up a new folder.
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3. Click Browse to choose a folder and clickOK.

4. When the software senses new media within the folder, a message displays in the lower right
corner of the application. Click the message to view your notifications.

5. Click the message and follow the steps for Importing from a File.

Writing Image Properties (Metadata)
Historian 4.0 writes metadata to your vault, savingmore and detailed information about each file.

Metadata is "data about data." Each piece of metadata serves as a building block that tells you
more about that file. For example, an individual image may include things like the file name,
description (story), and rating.

If keywords or metadata are already associated with a file, it will be includedwhen the file is
imported into the software. Historian will ask you if you want to create a tag for each of the key-
words available. Learn more about keywords inWorking with Keywords on Import. Metadata is
updatedwhen an image is exported outside the vault, when the vault is closed, or when you man-
ually update the information.

Historian 3.0 was the first version to store such extensive data. You can update your older vaults
by writingmetadata. Historian 4.0 makes it easy to write metadata to your vault.

l Write bulk metadata
l Write individual metadata
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Write Bulk Metadata

To update or write metadata to your vault, perform the following steps:

1. In the Media Library, select the Vault ribbon. ClickWrite item properties.

2. TheWrite Item Properties dialog displays. You have two options:

l Update item properties for only those images changed since the last update.
l Update item properties for all the images in the current vault.

Note: If you are updating an older vault, update the metadata for all the images in the vault.

3. ClickUpdate Now. The software quickly updates your metadata.

4. A confirmation message is displayed at the end of the update.

Update Individual Metadata

You can update the metadata for an individual file.

1. In the Media Library, select an image.

2. From the drop-down arrow, select Tools > Write item properties to files.
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3. The metadata updates for that image.

Note: If other items have pending property changes, these items are updates as well.

Copyright © 2005-2013 Panstoria, Inc. 275




	Introduction
	About the Software
	Windows System Requirements
	Activating Your Software
	Accessing the Internet
	Automatically Updating Your Software
	Upgrading Your Software
	Compatible Devices and File Formats
	Accessing Tutorials
	Contacting Customer Support
	Upload a Diagnostic Report


	Navigating the Software
	Using Ribbons
	Working in the Media Library
	Working in Bookshelf View
	Working with Album View
	Working in Editing View
	Using the Drop-Down Arrows
	Using Your Right-Click Button
	Using Keyboard Shortcuts
	Using Thumbnails
	Viewing and Modifying Selected Items
	Using the Welcome Page
	Setting User Options
	General Settings
	Imports
	Editing
	Metadata
	Backup
	Email
	Automatic Updates
	Spell-Checking
	Technical Support


	Working with Media
	Getting Media
	Working With Audio and Video
	Importing From a File
	Importing From Your Camera
	Importing From Social Media
	Importing From Your Scanner
	Import the Entire Image
	Import Selected Areas

	Searching for Media Files
	Working with Keywords On Import

	Organizing Media
	Working With Categories
	Adding a Category
	Editing a Category
	Deleting a Category

	Working With Tags
	Adding a Tag
	Editing a Tag
	Deleting a Tag

	Adding and Removing Items Within Tags
	Drag and Drop
	Add an Item Using the Drop-Down Arrows
	Remove Media From a Tag

	Using Ratings
	Assigning Ratings
	Viewing Media Based on Ratings

	Copying to Windows from the Organizer Panel
	Working with Time
	Working With Time
	Timeline Options
	Filtering Media with Time

	Sizing the Timeline
	Assigning Dates
	Searching With the Timeline


	Displaying Media
	Displaying Media
	Display by Category
	Display by Tag
	Displaying Multiple Tags

	Displaying Media with Views Options
	Displaying Media Using Find Options
	Displaying Media Based on Ratings
	Filtering Media with Time
	Using Date Views
	Displaying Home View
	Viewing Item Details
	Specific Sorting
	Zooming

	Accessing Item Information
	Modifying Item Properties
	Deleting an Item
	Delete an Item From a Vault
	Delete While Editing
	Delete an Item From an Album

	Accessing Backup History

	Using Facial Recognition
	Overview of Facial Recognition
	Understanding Facial Recognition
	Face Tags
	Missing Faces

	Turn on Facial Recognition
	Automatically Scan for Faces
	Scan for Faces on Import
	Add Missing Faces Using Preview
	Add Missing Faces During Editing
	Add Missing Faces in Item Properties

	Editing Images
	Reviewing Changes
	Undo a Change
	Using the Reset Option
	Saving Your Changes
	Using Save
	Using Save As

	Using Revisions
	Saving a New Revision
	Accessing Your Revisions

	Using the Color Picker
	Using Right-Click When Editing
	Understanding the Histogram Panel
	Modifying Your Images with an External Editor
	Image Ribbon
	Image Options
	Using the Image Section
	Using the Image Assistant
	Using the Image Assistant: Introduction




	Creating Albums
	Using Bookshelves
	Adding a Bookshelf
	Edit a Bookshelf
	Deleting a Bookshelf

	Using the Work Area
	Options
	Using the Work Area to Build an Album
	Sharing Journaling Boxes

	Adding Albums
	Add an Empty Album
	Adding an Album from the Work Area
	Add an Album from a Tag

	Opening Albums
	Editing and Deleting Albums
	Choosing Album Layouts
	Cropping Album Photos
	Adding Journaling Boxes to Your Album
	Modify the Default Journaling Box Appearance
	Closing and Saving Albums
	Using Empty Space
	Printing an Album

	Sharing Images and Albums
	Sharing Your Memories
	Sharing to a File
	Sharing to a File
	Advanced Options

	Sharing to CD/DVD
	Export to a Disc
	Advanced Options

	Share to E-mail
	E-mail Your Media
	Advanced Options

	Add an Email Account
	Creating a Slide Show
	Sharing to Windows Movie Maker
	Sharing to Movie Maker
	Advanced Options

	Sharing to Other (Flickr, Facebook, Picasa)
	Sharing to Social Media
	Advanced Options

	Sharing to Artisan
	Advanced Options


	Printing Images and Albums
	Printing to a Local Printer
	Low Pixel Warning
	Choose a Print Layout
	Print to a Web Provider

	Managing Your Vault
	Understanding the Media Vault
	Media Library
	Organization
	Albums

	Managing Your media vault
	Assign a Vault Preview Image
	Open a media vault
	Create a New Vault
	Recover a Media Vault
	Vault Ribbon
	Using the Vault Ribbon
	Repairing Your media vault
	Creating an Incremental Backup
	Create a Full Backup
	Write Directly to CD or DVD
	Write to Hard Drive Now, Burn CDs or DVDs Later
	Using Shadow Copies (Automatic Protection)
	Undeleting Items
	Restore Items from the Recycle Bin
	Permanently Delete Items from the Recycle Bin

	Merge Vaults
	Exporting a Vault
	Setting Up Watch Folders
	Writing Image Properties (Metadata)
	Write Bulk Metadata
	Update Individual Metadata



	Bookmarks
	General
	importing
	editing
	metadata
	backup
	email
	autoupdates
	spelling
	support
	entireimage
	selectedarea
	addingcat
	editingcat
	deletingcat
	addingcat
	editingcat
	deletingcat
	dragandropimages
	rightclickadd
	rightclickremove
	assigning ratings
	viewing_based_on_ratings
	category
	sort box
	multiple
	delete_MV
	delete_edit
	delete_album
	step6
	save
	save as
	Saving
	Accessing
	Using the Image Assistant: Step 1
	Using the Image Assistant: Step 2
	Using the Image Assistant: Step 3
	Using the Image Assistant: Step 4
	Using the Image Assistant: Step 5
	Using the Image Assistant: Step 6
	Using the Image Assistant: Step 7
	Crop and Rotate
	Cropping Your Images
	Free Rotating Your Images
	Rotating Your Images

	Quick Fix
	Applying Auto Fix
	Adjusting Light
	Convert to Black and White
	Converting Sepia

	Red-eye
	Reducing Red Eye
	Using the Red Eye Brush

	Adjust Ribbon
	Selecting
	What is a Selection?
	Choosing Selection Tools
	Common Selection Options
	Deselecting an Area
	Blending

	Color and Light
	Adjusting Light
	Adjusting Color Balance
	Applying Hue and Saturation
	Adding Color Wash
	Matching Color
	Adjusting  Temperature
	Adjusting Color Curves
	Adjusting Levels

	Convert
	Convert to Black and White
	Converting Sepia

	Focus
	Choosing Soften Options
	Choosing Sharpening Options
	Clean Up: Applying Despeckle
	Clean up: Applying Median

	Other Options
	Resizing Your Images
	Applying Filters


	Touchup Ribbon
	Using Brushes
	Using Cloning Tools
	Cloning Within an Image

	Using an Alternate Clone Source
	Applying Paint
	Using the Smudge Brush
	Using Lighten
	Using the Darken Brush
	Using Blur
	Colorizing Your Images
	Decrease Color
	Increasing Color


	options
	workarea
	sharing
	add_empty
	add_folder
	editing
	deleting
	addempty
	removeempty
	restorebin
	deletebin
	bulk
	indiv


